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Course introduction

Welcome to Solid Edge self-paced training. This course is designed to educate you in the use of
Solid Edge. The course is self-paced and contains instruction followed by activities.

Start with the tutorials

Self-paced training begins where tutorials end. Tutorials are the quickest way for you to become
familiar with the basics of using Solid Edge. If you do not have any experience with Solid Edge,
please start by working through the basic part modeling and editing tutorials before starting self-paced
training.

Tutorials

Adobe Flash Player required for videos and simulations

To watch videos and simulations, you must have the Adobe Flash Player version 10 or later
installed as a plug-in to your browser. You can download the Flash Player (free) at the
http://get.adobe.com/flashplayer
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Lesson 1: Surface construction

Solid Edge provides two distinct 3D modeling styles: solid modeling and surface construction.

The solid modeling method

1. A product's function is the primary concern and aesthetics are purely an afterthought.

2. Solid Edge is an industry leader of this modeling style and exhibits these additional characteristics:

• The various modeling operations are identified as features.

• A history tree of features is maintained.

• All properties used in defining a feature can be edited at any time.
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Lesson 1: Surface construction

The surface modeling method

1. Many consumer products are designed using surface modeling techniques due to the market's
emphasis on style and ergonomics; therefore, a model's aesthetics is the number one concern
and key element in the design process. Product function is only a secondary consideration.

2. Like the solid modeling features, Solid Edge extends this style by making each point, curve, and
surface an entity that knows how it was created, and can be edited at any time.
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What is surfacing and why use it?
The solid modeling method is typically used when modeling with solid features. The following are
key features of the solid modeling approach:

• It is characterized by 2D sketches/profiles used in creating extrusions, revolutions, and lofts to
form solids, and blends on the edges of solids.

• It most often involves the addition or subtraction of material using analytic shapes.

• The model's topology is driven by faces.

• Holes are used for alignment.

• Feature faces are used for alignment as well as for mating with other features.

• Edges are rounded for safety and strength.

• Edges and faces are primarily analytic-based.

Modeling with surface-based features typically begins with a wire frame, from which surfaces are
generated. Key features of surface modeling:
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• It is characterized by control points used to define 2D and 3D curves.
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• A model's topology is driven by edges and curves. Edges and faces are mainly based on splines.

• Surface shapes are very important, therefore the ability to directly edit underlying curves and
edges is crucial.

• Highlight lines, silhouette edges and flow lines of a model are important.
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Surface construction advantages
For some types of parts, the surface modeling approach offers distinct advantages. For example,
when modeling the faucet shown using revolved features, the shape of the edges (1) is the result of
two intersecting surfaces. To change the shape of the edges, you must edit the surfaces. Often it is
difficult to get the surface aesthetics you want.

With a surface modeling approach, you have much more control by using character curves. Character
curves can be hard edges or soft edges. Hard edges are actual model edges (1), while soft edges
are theoretical, view-dependent edges, such as when viewing a curved surface (2) from the side (3).
Soft edges are also known as silhouette edges. Both types of edges are important for defining the
flow, aesthetics, and overall shape of a surface.
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Surface construction overview
Solid Edge provides two distinct 3D modeling styles: solid modeling and surface construction.

Many surface construction features require you to define cross section and guide curves. You can
define cross section and guide curves using analytic elements or B-spline curves.

An analytic element can consist of:

• A 2D element: Line, arc, circle, ellipse, parabola, or hyperbola.

• A derived element: such as the intersection of a cone and a plane.

• A 3D element: a cube, sphere, cylinder, cone, or torus.

A b-spline element can consist of:

• A 2D element, such as a B-spline curve.

• A derived element, such as the intersection of two non-planar surfaces.

• A 3D element, such as a 3D B-spline curve or free-form surface.

Note

A spline was originally a tool made from wood or thin metal which was used to draw a
curve through points.
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General surface modeling workflow
1. Create control drawings.

Definition: Control Drawings are 2D drawing views defining the top, side, and end views. Typically
one or two views dominate (define the majority of the shape).

Part environment: You can create control drawings directly by drawing on reference planes.
Pierce points aid in connecting curves.

Draft environment: You can create control drawings in 2D, then use Copy and Paste to transfer
the 2D elements from Draft into Part. Also, you can use Create 3D or import sketches.
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Tip

While drawing any sketch element in either the Part or Draft environment, use Line
Color to help distinguish edges and construction edges in the control drawing.

• Draw all character curves.

• Do not over draw. Do not model rounds, ribs, or features best created with solid features.

• Capture design intent. Add dimensions and constraints.

• Create simple B-splines with few Edit Points.

• Make sure view sketches register.

• Build edge continuity into your sketches.

2. Use 2D geometry to develop 3D curves.

• Project curves from control drawings.

• You may need some construction surfaces to generate 3D curves. This is very important in
reducing modeling steps.

• 3D curves give simplified control over edges.

• Capture your design intent by using control drawings.

• Without 3D curves, character edges may not be captured.
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• Lack of 3D edges eliminates design intent and adds more modeling.

• With 3D curves, design intent is preserved and modeling is reduced.

• You can easily change the shape by altering the character curves for the respective view.

• Creating 3D edges guarantees an accurate design and reduces modeling steps.

• Making changes to the 3D curve is simple. Edit the character curve in the control drawing.
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• Repeat the process until all 3D curves are created

o A wireframe representation of the model should result.

o All 3D curves should be touching.

spse01560 Modeling a part using surfaces 1-11

Surface construction



Lesson 1: Surface construction

3. Use 3D curves to develop surfaces.

• BlueSurf command.

Inputs are guides and sections.

• Swept command.

Inputs are guides and sections.

• Bounded command

N-sided patch.
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4. Create a solid and add appropriate solid based features.

• Stitch together surfaces

• Add solid-based features

o Thinwall

o Stiffening Rib

o Hole

o Round

o Web network

o Lip

5. Tweak.

• Analyze edge continuity using:

o Curvature Comb

o Zebra Stripes

• Edit character curves

• Edit tangent vectors

• Edit vertex mapping
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Working with points, curves, and surfaces
You can use commands in Solid Edge to create points, curves, and surfaces. These elements are
typically used to construct part features, and are often referred to as construction elements. For
example, you can use a single, curved surface to replace several planar faces on a model. Using
points, curves, and surfaces helps you model complex design scenarios more quickly.

You can also use these commands when working with foreign data that you have imported into
Solid Edge.

For some model types, you may not use the solid modeling commands until very late in the modeling
process. Complex, free form parts often require that you begin the modeling process by defining
points and curves that are used to define and control the surfaces that comprise the model. Surfaces
are then generated, and in the final steps, the surfaces are stitched together to form a solid model.
For more information on this type of workflow, see the Surface construction Help topic.

Note

Construction elements that drive other features have a parent-child relationship with the
features they drive. If you delete a construction element that is a parent to another feature,
you can invalidate the other feature.
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Displaying points, curves, and surfaces

The construction elements you create are listed in the Feature PathFinder window. You can
control whether construction elements are listed in Feature PathFinder using the PathFinder
Display commands on the Feature PathFinder shortcut menu. For example, to display construction
elements in Feature PathFinder, click the right mouse button within Feature PathFinder, then point
to PathFinder Display, and then set the Constructions option.

Note

You can change the default color for construction elements using either the Color Manager
command or the Colors tab on the Options dialog box.

When you use construction elements to help you construct new features on a solid model, the
construction elements are not consumed by the new feature. For example, if you use a construction
surface to help you define the extent for a protrusion, a trimmed copy of the construction surface is
used to create the protrusion. The construction surface remains, but it is hidden automatically.

You can control the display of construction elements in the graphic window using the Construction
Display command or the Show and Hide commands on the shortcut menu. When you hide a
construction element, its entry in Feature PathFinder changes to indicate that it is hidden.

When working with Solid Edge documents that contain construction surfaces and a solid design
body, it can be useful to hide the design body while you are working with the construction surfaces.
You can use the Show Design Body and Hide Design body commands to control the display of
the design body.
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Creating points, curves, and surfaces

You can create these elements using the following methods:

• Generate them using other geometry on the model. For example, you can create points and
curves at the intersection of other curves and surfaces.

• Create them from scratch. For example, you can create extruded, revolved, and swept surfaces
using the Solid Edge construction surface creation commands.

• Generate them using an external file. For example, you can create a helix curve using the Helical
Curve command or coordinate data in a spreadsheet using curve by table.

• Import them from another CAD system. For example, you can import surfaces and solids from
a third-party CAD system.

• Generate them as a part copy from another Solid Edge part. For example, you can create
construction geometry using the Part Copy command.
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Using points and curves

You can use points and curves in the following ways:

• To help you create other features, you can use a construction point or curve as a path or cross
section for lofted and swept features.

• To help you create a reference plane, you can use a construction curve as input to the Plane
Normal To Curve command.

• To help you define the extents of another feature, you can use keypoints of construction curves
to define the extent for a feature.

For example, you can use 3D construction curves as paths during the creation of swept features.

You can use the Intersection Point command to create associative points at the intersection of
edges and other curves. You can then use these points as input to define the extents of a feature.
You can also use points as cross sections when creating lofted features.

You can create open or closed curves using the Intersection Curve, Keypoint Curve, Derived
Curve, and Curve By Table commands. You can then use these curves to define paths and cross
sections for lofted and swept features, and as profiles for profile-based features and construction
surfaces.

The Project Curve command projects a curve onto a part face. You can then use the projected
curve as a profile for either a protrusion or a cutout feature. This is a useful technique for creating
embossed text on a curved surface.

The Split Curve command splits a curve into multiple curves. Splitting a curve can make it easier to
create other geometry, such as a surface by boundary or a normal protrusion.
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Using surfaces

The surfacing commands help you create complex parts and surface topology more easily. You can
use surfaces in the following ways:

• To define the projection extents when extruding a feature.

• To replace existing part faces.

• To divide a part into multiple parts.

• To create a new surface or solid by stitching together separate surfaces.

• To repair a model you imported from a third-party CAD system.

Construction surfaces are commonly used as projection extents when extruding a feature. For
example, you can create a construction surface, then use the surface as input during the Extent
step when constructing a protrusion.

You can use the Offset Surfaces command to offset a new surface. The options on the command
bar allow you to specify whether you want to offset a single face, a chain of faces, or all the faces
that make up a feature.

You can use the Stitched Surface command to stitch together Solid Edge surfaces, as well as
surfaces created with another CAD system and then imported into Solid Edge.
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You can also create surfaces using the Part Copy command. If the Copy As Construction option is
set in the Part Copy Parameters dialog box, the part copy is created as a construction surface.
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Evaluating surfaces

When working with surfaces, it is sometimes useful to visualize the curvature of a surface to
determine if there are surface discontinuities and inflections. You can use the Zebra Stripes
command to display zebra stripes on the model.

You must also shade the active window using the Shaded or Shaded With Visible Edges commands
to display zebra stripes.
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Evaluating and repairing foreign data

When you import surfaces that do not form a closed volume, they are imported as construction
geometry. If the imported surfaces form a closed volume, you have the option to create a solid body.

If the imported surfaces do not form a solid body in Solid Edge, but were created as a solid body in
the other CAD system, the accuracy of the data prevented it from being converted into a solid body in
Solid Edge. Typically, the surface-to-surface matching tolerances used in the source system were
larger than the Parasolid modeling kernel requires for successful stitching of the surfaces into a solid
body. Some CAD systems allow surface-to-surface matching tolerances that are quite large, in some
cases larger than the manufacturing tolerances of the manufactured part. The surface-to-surface
matching tolerance requirements of the Parasolid modeling kernel are more exacting.

You can use the Geometry Inspector command to determine what problems the model has and
then you can use the construction commands to modify the model to repair the problem areas. For
example, there may be surfaces that did not import correctly, or there may be gaps or overlaps
between individual surfaces in the model. Geometry Inspector evaluates the model and builds a list of
the problem areas and provides suggestions as to how you can repair the problems.

If there are areas that did not stitch properly, you can use the Show Non-Stitched Edges command
to display the non-stitched areas. You can then use the other commands on the Surfacing tab to
repair the existing surfaces, or create new surfaces and stitch them into the model. You can also
delete surfaces that would be easier to recreate from scratch than to repair.

Both curve and surface manipulation commands are available for creation and modification
of construction elements. You can use the Derived Curve, Split Curve, Project Curve, and
Intersection Curve commands to create new curves or modify existing curves. You can use the Trim
Surface, Extend Surface, and Delete Face commands to modify or delete construction surfaces.
You can use the Extruded Surface, Revolved Surface, Swept Surface, Lofted Surface, and
Bounded Surface commands to create new construction surfaces. For example, if an imported
surface overlaps another surface, you can use the Derived Curve command to extract a curve from
the edge of the surface it overlaps, then use the new derived curve as input with the Trim Surface
command to trim the existing surface.

spse01560 Modeling a part using surfaces 1-21

Surface construction



Lesson 1: Surface construction

If the non-stitched edges are the result of a missing surface, you can use the construction commands
to create a new surface and stitch it into the model. For example, you can create an extruded,
revolved, swept, and lofted construction surface to close a gap in a model.

When repairing imported data, you may need to try several approaches before finding one that
succeeds. For example, if you are unsuccessful creating a revolved surface, try creating an lofted
surface. The tolerance issues inherent with imported data can make model repair difficult.

After you have repaired a surface, or created a new surface, you can then use the Stitched Surface
command to add the new surface to the model. If the stitched surfaces form a closed volume, you
have the option to create a solid body. You can then use the solid body to complete the modeling
process.
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Lesson 2: Creating and editing curves

Objectives

After completing this lesson, you will be able to:

• Create curves.

• Edit curves.

• Analyze curves.

• Create BlueDots.

• Edit BlueDots.
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Lesson 3: Surface modeling approach

The backbone of surface modeling is made up of cross sections and guides. Cross sections and
guides can be of entity type analytic or spline.

An analytic entity type consists of:

• 2D: Lines, arcs, circles, ellipse, parabola, hyperbola.

• The intersection of a plane and a cone.

• 3D: Cubes, spheres, cylinders, cones, tori.

A spline entity type consists of:

• 2D: constructed spline curves, derived curves.

• 3D: derived spline curves.

A solidmodeling method using revolved features results in no edge control and difficult edits. Edge (1)
is a result of the intersection of two revolved surfaces. You do not have direct control over the result.
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A surface modeling method results in exact edge control and edges are based on character curves.
You have direct control over edges such as (2).
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Lesson 4: Overview of splines

A spline is a standard curve in most CAD systems. Unlike lines and conic curves, generally
categorized as analytics, the spline can be adjusted to virtually any shape in two or three dimensions.
Their flexible nature makes splines the foundation for surface modeling.

A spline entity type consists of:

• 2D: constructed spline curves, derived curves.

• 3D: derived spline curves.

Note

Originally, a spline was a stylist's tool made from wood or thin metal and used to draw a
curve through points.
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Shown below is a 2D spline.

Shown below is a 3D surface based on a spline.

For the remainder of this course, the term curve is used instead of splines. Just remember that curves
are splines. Two types of curves are discussed:

• Constructed–You have direct control of constructed curves.

• Derived–Derived curves are controlled by the method used to create them. Derived curves
cannot be edited directly.
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Lesson 5: Curve command

Use the Curve command to draw a smooth, B-spline curve by points. You can click and drag to
define a freehand curve, or you can click to create edit points to define the curve. If you click edit
points, you must define at least three points to create the curve.

When you create a curve, edit points (1) and curve control vertex points (2) are created to help you
edit and control the shape of the curve.

Closing curves

You can use the Closed option on the Curve command bar to create a continuous line that forms a
closed curve connected tangentially at the first and last point you click.

Closed option Result

Off
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Closed option Result

On

When editing a curve created from edit points, you also can use the Closed option to:

• Close an open curve, without adding points.

• Open a closed curve, without deleting points.

You cannot use this option to modify a freehand curve.

Displaying curves

You can use the options on the Curve command bar to control the display of a curve.

The Add/Remove Points button adds or removes edit points along the curve. When you add an edit
point, the shape of the curve does not change. If the number of edit points on the curve is the same
as the number of control vertex points, adding an edit point adds a corresponding control vertex point.
The control vertex point moves to maintain the shape of the curve.

When you remove edit points, the control vertex points move, and the shape of the curve changes.

Note

If there are only two edit points on the curve, you cannot remove an edit point from the curve.

See Insert or remove points on a curve.
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Curve command

The Show Polygon button turns on the control polygon of the curve. This polygon displays when the
curve is not selected.

The edit points and control vertex points are handles that you can drag to change the shape of
the curve.

Note

You can also use these points as keypoints for relationships and dimensions.

The Show Curvature Comb button displays the curvature comb for the curve. This helps you
determine how quickly or gradually curves change and where they change direction.

You can use the Curvature Comb Settings command to control the density and magnitude of
the curve.

Editing curves

The Curve command bar controls how the shape of the curve changes when you make changes to
the edit points and control vertex points.

The Shape Edit and Local Edit buttons control the shape of the curve when you move a point on
the curve.
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Lesson 5: Curve command

When you select the Shape Edit button, you affect the shape of the entire curve when you move
a point on the curve.

When you select the Local Edit button, you affect the shape of the curve around the edit point.

With Local Edit, if you drag a vertex point on an unconstrained curve, no other vertex points will
move. However, if you drag a vertex point on a curve that has some relationships, then other vertex
points may move as well. This allows the curve to adapt to the new location of the vertex point you
moved while still maintaining the relationships.

Note

You cannot drag an edit point that is fully constrained.

You can select the Curve Options button to display the Curve Options dialog box. You can use this
dialog box to change the number of degrees for the curve and to specify the relationship mode for the
curve. You can set the relationship mode to:

• Flexible

• Rigid
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Curve command

In Flexible mode you can use external relationships to control the shape of the curve. For example,
you can apply a dimension relationship on the curve and as you make changes to the dimensions,
the shape of the curve automatically updates.

In Rigid mode you cannot use external relationships to control the shape of the curve. Instead, the
curve shape remains unchanged and the curve simply rotates.

Dimensioning curves

When placing a smart dimension on a curve, the dimension result is measured as curve length
(2) and is locked (1).
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Lesson 5: Curve command

Simplifying curves

You can use the Simplify Curve command to simplify a polygon-based curve by reducing the number
of edit points and control vertex points on a curve. The Simplify Curve dialog box increases or
decreases a fit tolerance for the curve.

Note

Simplifying a curve can cause the relationships placed on a curve to be deleted.
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Lesson 6: Curve definition

The shape of a curve is dependent on the number of control and edit points. These elements are
determined by standard polynomial expressions.

Curve order

The order of a curve is equal to the degree of the curve, plus 1 (Order = Degree +1).

A polynomial curve is defined as:
x(t) = x0 +x1(t1) + x2(t2) + x3(t3)
y(t) = y0 +y1(t1) + y2(t2) + y3(t3)
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Lesson 6: Curve definition

Determining control vertices

If the number of edit points is two or three, then the number of Control Vertices = Order.

Example:

Edit points = 3
Degree = 8
Order = 9 (Degree + 1)
Control Vertices = 9

If the number of edit points is >= 4, the number of control vertices is (n+2) + {(n-1) x (k-4)}.
Where n = Edit Points, and k = Order.
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Curve definition

Example:

Edit points = 7
Degree = 5
Order = 6 (degree + 1)
Control Vertices = 21

For more information on curve options, refer to Curve Options dialog box.
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Lesson 7: Curve display and edit

Displaying curves

You can use the options on the Curve command bar to control the display of a curve.

The Add/Remove Points button adds or removes edit points along the curve. When you add an edit
point, the shape of the curve does not change. If the number of edit points on the curve is the same
as the number of control vertex points, adding an edit point adds a corresponding control vertex point.
The control vertex point moves to maintain the shape of the curve.

When you remove edit points, the control vertex points move, and the shape of the curve changes.

Note

If there are only two edit points on the curve, you cannot remove an edit point from the curve.

See Insert or remove points on a curve.

The Show Polygon button displays the control polygon of the curve, which you can use to edit
the curve.

The Show Curvature Comb button displays the curvature comb for the curve. This helps you
determine how quickly or gradually curves change and where they change direction.

The Show Edit Points and Show Control Vertex Points shows the edit points and control vertex
points on a curve. The edit points and control vertex points are handles that you can drag to change
the shape of the curve.

Note

You can also use these points as keypoints for relationships and dimensions.
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Lesson 7: Curve display and edit

Editing curves

You can edit curves at any time via one of two methods for editing curves.

1. Edit Profile mode: Just like editing a sketch.

2. Dynamic Edit mode: Shows all of the control and edit points.

When you move a control point or edit point, the curve updates automatically; any surface that has
the curve as one of its defining entities will update dynamically.

The Curve command bar controls how the shape of the curve changes when you make changes to
the edit points and control vertex points. These options are only available in Edit Profile Mode

Add/Remove Points Adds and removes points on a curve.

Show Polygon Display of the control polygon on a curve

Show Curvature Comb Displays the curvature combs on a curve.

Show Edit Points Displays the edit points on a curve.

Show Control Vertex Points Displays the control vertex points on a
curve.

Shape Edit Affects the shape of the entire curve when
points are moved

Local Edit Affects the curve shape around the edited
point.

Close Curve Specifies a open curve to be closed.

Simplify Curve Reduces the edit points on a curve.

Curve Options Displays the curve options dialog.

Below are some examples of curve editing
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Curve display and edit

The Shape Edit and Local Edit buttons control the shape of the curve when you move a point on
the curve.

When you select the Shape Edit button, you affect the shape of the entire curve when you move
a point on the curve.

When you select the Local Edit button, you affect the shape of the curve around the edit point.

With Local Edit, if you drag a vertex point on an unconstrained curve, no other vertex points will
move. However, if you drag a vertex point on a curve that has some relationships, then other vertex
points may move as well. This allows the curve to adapt to the new location of the vertex point you
moved while still maintaining the relationships.

Note

You cannot drag an edit point that is fully constrained.

You can select the Curve Options button to display the Curve Options dialog box. You can use this
dialog box to change the number of degrees for the curve and to specify the relationship mode for the
curve. You can set the relationship mode to:

• Flexible

• Rigid
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Lesson 7: Curve display and edit

In Flexible mode you can use external relationships to control the shape of the curve. For example,
you can apply a dimension relationship on the curve and as you make changes to the dimensions,
the shape of the curve automatically updates.

In Rigid mode you cannot use external relationships to control the shape of the curve. Instead, the
curve shape remains unchanged and the curve simply rotates.
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Lesson 8: Simplify Curve command

Reduces the number of edit points for a curve.

• Curve data can be manually created or can be read in from foreign data.

• Manually created curve data usually contains a limited number of control points.

• Foreign data may come from a digitized set of control points, which could contain a large amount
of points.

• Simplify curve is a tool that allows you to define a tolerance to reduce the number of edit points
and control vertices.

The command works differently depending on the type of curve. For edit point based curves, once
you reduce the number of edit points to two, the command reduces the control poles. Control polygon
based curves only have two edit points, so the command reduces the control poles.

Select the Simplify Curve command from the command bar or right-click on a curve and select
Simplify to access its dialog box; for more information, refer to the Simplify Curve dialog box topic:

Simplify Curve dialog box
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Lesson 9: Convert To Curve command

The Convert To Curve command converts analytic geometry into a B-spline curve. B-spline
curves are typically easier to use during surface modeling creation than analytic elements. For
example, suppose you create a model with surfaces defined with analytic elements. You can use
this command to convert the analytic elements to B-spline curve to obtain the control provided by
B-spline curves.

Why convert?

• Analytical elements are often utilized as cross-sections and guide paths during surface creation.
The resulting surface has inherent limitations on how it can be edited, as lines remain linear and
arcs retain their circular definition.

• Curves provide more control, therefore are easier to use.

• Increased control facilitates edits.

o Allows modification of a curve’s properties.

o Defaults to a degree of 2. You can increase the degree and add edit points for more control.

• Once converted, curve shapes will have greater control over associated complex surfaces.

o Simplifies the manipulation of a model from initial concept through final production.

• Can be used on the following analytics:

o Single non-connected analytic element: conversion results in a single non-connected
B-spline curve.

o Multiple connected analytic elements.

■ Non-tangent elements: conversion results in multiple connected B-spline curves with
no cusps.

■ Tangent elements: conversion results in multiple connected and tangent B-spline curves.

Note

You cannot convert B-spline curves to analytic geometry.
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Lesson 9: Convert To Curve command

Note

You can only convert analytics to curves while in the Edit Profile mode.

(1) Analytic line and arc element
(2) Analytic elements converted to curves
(3) Curve edits
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Lesson 10: Activity: Drawing and editing a curve

Overview

In this activity, you learn to use the curve creation tools. Curves are the backbone for creating
and controlling surface shape.

Objectives

After completing this activity you will be able to:

• Create curves.

• Edit curves.

• Analyze curves.
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Lesson 11: Open part file

▸ Open surface lab 2–01.par.
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Lesson 12: Draw a curve

Begin the activity by drawing a curve with edit points in space.

▸ Select Home tab→Sketch group→Sketch .

▸ Select the reference plane shown.

▸ Click Home tab→Select group→Select .

▸ In PathFinder, click the check box to display Sketch A. Use the sketch elements in Sketch A
as a guide to where to place the edit points.

spse01560 Modeling a part using surfaces 12-1



Lesson 12: Draw a curve

▸ Select Home tab→Draw group→Curve .

▸ Click just above each of the construction points from left to right as shown. After clicking above
the last point, right-click the end the command. Select Close Sketch, then Finish on the
command bar to create the curve.
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Lesson 13: Hide the sketch containing edit points

▸ Click Home tab→Select group→Select.

▸ In PathFinder, turn off the display of Sketch A.
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Lesson 14: Edit the curve shape

▸ Select the curve, and on the command bar, choose Edit Profile. Select the curve again, and
notice the display of the edit points and control polygon.

The Edit Curve command bar displays. On the command bar, the Local Edit option is on.

Note

With the Local Edit option, when you drag an edit point or control point, the shape of the
curve changes near the point you drag. With Shape Edit, the entire curve changes shape
slightly, preserving the overall shape of the curve.

▸ With the Local Edit option selected, drag the edit point shown to observe how the curve shape
changes.
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Lesson 14: Edit the curve shape
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Edit the curve shape

▸ After editing the curve, on the Quick Access toolbar, click the Undo command.

This returns the curve to its original shape.

▸ Select the curve. On the Edit Curve command bar, select the Shape Edit option.
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Lesson 14: Edit the curve shape

▸ With the Shape Edit option selected, drag the edit point shown and observe how the curve
shape changes.

▸ After editing the curve, click the Undo command.
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Lesson 15: Add more control to the curve

▸ Select the curve. On the Edit Curve command bar, click the Curve Options button .

▸ In the Curve Options dialog box, ensure the Degree is set to 3 and click OK.

▸ On the Edit Curve command bar, click the Add/Remove Points button .
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Lesson 15: Add more control to the curve

▸ Add edit points at the two locations shown below.

Note

You can only insert one edit point at a time with the Add/Remove Points button. You
can either select the button again, or you can press and hold the Alt key while you click
the curve to place as many points you need.

▸ Edit the curves again to observe how the shape changes. Undo to return the curve to its original
shape.
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Add more control to the curve

▸ In the Curve Options dialog box, change the Degree from 3 to 5 and click OK. Observe the
change to the control polygon.

▸ Edit the curve again with both Local Edit and Shape Edit options to see how the curve shape
changes now with the higher degree. Be sure to undo any changes you make to the curve.

Local Edit

spse01560 Modeling a part using surfaces 15-3

Add more control to the curve



Lesson 15: Add more control to the curve

Shape Edit
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Lesson 16: Inspect the curve using Curvature Comb

▸ Select the curve. On the Edit Curve command bar, select the Show Curvature Comb button

.

Note

You can adjust the curvature comb display using the Curvature Comb Settings dialog
box.

▸ Select Inspect tab→Analyze group→Curvature Comb Settings.

Note

Density controls the number of normal vectors. Magnitude controls the length of the
vectors.
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Lesson 16: Inspect the curve using Curvature Comb

▸ Move the slider bars and observe the curvature comb display.

▸ In the Curvature Comb Settings dialog box, clear the Show curvature combs box and click
Close.

▸ Click Home tab→Close group→Close Sketch to complete the sketch.

▸ On the Sketch command bar, select Finish.

▸ In PathFinder, turn off the sketch display.
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Lesson 17: Draw a curve connected to elements

▸ In PathFinder, turn on the display of Sketch B.

▸ Select Sketch B and click Edit Profile.

▸ Click Home tab→Draw group→Curve .
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Lesson 17: Draw a curve connected to elements

▸ Draw a curve with edit points at the endpoints of the lines (1-5) shown below. Make sure to
get the endpoint connect symbol before clicking. After placing the last edit point, right-click to
complete the curve.

Endpoint Connect Symbol

17-2 Modeling a part using surfaces spse01560

Lesson 17: Draw a curve connected to elements



Draw a curve connected to elements

▸ Select the dimensions and edit their values as shown to observe how the curve is constrained to
the dimensioned elements.
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Lesson 18: Constrain the curve

▸ Delete all elements in the sketch except for the curve.

▸ Select the curve.

spse01560 Modeling a part using surfaces 18-1



Lesson 18: Constrain the curve

▸ Click Home tab→Relate group→Horizontal/Vertical .

Note

Notice that the edit points and control vertices display as crosses. If you position
the cursor over a cross, you will see the following denoting if it is an edit point (1) or
control vertex (2).

Click point (3) and then click point (4). Points (3) and (4) will remain aligned horizontally.
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Constrain the curve

▸ Place a dimension as shown between the horizontal reference plane and edit point (5).

▸ Place a dimension as shown between the horizontal reference plane and edit point (1).
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Lesson 18: Constrain the curve

▸ Add a vertical relationship between control vertex (6) and the center of the reference planes.

▸ Apply a final constraint to control vertices. Place two dimensions as shown between the vertical
reference plane and control vertices (7) and (8).

Note

More constraints are needed to make the curve symmetric about the vertical reference
plane. For this activity stop adding constraints at this point.
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Constrain the curve

▸ Edit the dimensions as shown and observe the curve shape constraints.

▸ Drag control vertex (6) down and observe how the curve shape changes while maintaining the
relationships you applied.

▸ Save and close the part file.
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Lesson 19: Summary

In this activity you learned how to draw and edit curves based on edit points and lines.

spse01560 Modeling a part using surfaces 19-1





Lesson 20: BlueDot command (ordered modeling)

Note

BlueDots are only available in the ordered modeling environment

A BlueDot is a control point where two curves or analytics connect, or where one curve and one
analytic connect, thereby providing a control point between the curves. It is a point which can edited
to suit design or styling needs.

Use the BlueDot command (ordered modeling) to create a control point (1) between two sketch
elements. You can connect the elements at their keypoints or at a point along the elements. The
BlueDot overrides any existing associativity of the elements. This allows you to edit the location of
the BlueDot or the elements it connects without regard to the order in which the elements were
constructed.

After you connect the keypoints of two elements with a BlueDot, you can edit the position of the
BlueDot to change the shape of the elements. Surfaces that were constructed using the elements
also update.

Refer to Connect sketch elements with a BlueDot for more info on BlueDot creation.
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Lesson 20: BlueDot command (ordered modeling)

Edit a BlueDot

To edit the position of a BlueDot, use the Select Tool to select a BlueDot (1), then click the Dynamic
Edit button on the Select command bar. When you edit the position of a BlueDot, you can use the
OrientXpres tool (2) to restrict the movement to be parallel to a particular axis or plane. You can then
drag the BlueDot to a new position (3). The wireframe elements and the surface also update.

When you use OrientXpres to restrict movement to a plane (1), you can move the BlueDot along
two axes simultaneously (2).
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BlueDot command (ordered modeling)

You can also reposition the OrientXpres tool by selecting the origin of the X, Y, and Z axes, and
then dragging OrientXpres to a new position.

You can use the BlueDot Edit command bar to specify whether the edit value is relative to its current
position or its absolute position with respect to the global origin of the document. The global origin is
the point where the three default reference planes intersect (the exact center of the design space).

When you apply a BlueDot to b-spline curves, you can also control how the curves react to the edit by
setting options on the Curve 1 and Curve 2 controls on the command bar.

Note

When you use a BlueDot to connect two elements, it affects the associative relationship of
the reference planes on which the elements lie. For example, if one of the elements lies
on a reference plane that was created parallel to another reference plane, the dimensional
offset value for the reference plane is deleted. When you edit the position of the BlueDot,
the reference plane can be moved to a new position to facilitate the repositioning of the
elements.

Refer to BlueDot Edit command bar for more information.
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Lesson 21: BlueDot Edit command bar (ordered modeling)

Note

BlueDots are only available in the ordered modeling environment.

Relative/Absolute Position
Specifies whether the value you type is relative to the BlueDot's current position or is based on
the global origin of the document. The global origin is the point where the three default reference
planes intersect (the exact center of the design space).

X
Sets the position for the x axis.

Y
Sets the position for the y axis.

Z
Sets the position for the z axis.

Curve 1
Specifies the edit method you want for curve 1. This option is only available for b-spline curves.
When you edit the position of a BlueDot that connects a curve to another element, you can set
the following options to control how the curve is modified.

Shape Edit—Affects the shape of the entire curve when you move a point on the curve.

Local Edit—Affects the shape of a limited portion of the curve around the edit point.

Rigid—Prevents the curve from being modified.

Note

This option is not available in Wire Harness.
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Lesson 21: BlueDot Edit command bar (ordered modeling)

Curve 2
Specifies the edit method you want for curve 2. This option is only available for b-spline curves.
This option is not available when editing BlueDots in Wire Harness. When you edit the position
of a BlueDot that connects a curve to another element, you can set the following options to
control how the curve is modified.

Shape Edit—Affects the shape of the entire curve when you move a point on the curve.

Local Edit—Affects the shape of a limited portion of the curve around the edit point.

Rigid—Prevents the curve from being modified.

Note

This option is not available in Wire Harness.
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Lesson 22: Connect sketch elements with a BlueDot

1. Choose Surfacing tab→Surfaces group→BlueDot .

2. Select a keypoint on the first element.

3. Select a keypoint on the second element.

Note

The first curve moves to intersect the second curve. Also, the shape and location of the
first curve may change, but the second curve maintains its initial shape and location.

Tip

• Each curve has four select zones: two endpoints, a midpoint and the curve itself.

• You can also use a BlueDot to connect elements at a point along the elements.

• You can edit the position of a BlueDot using the Select Tool and the BlueDot Edit
command bar.

• You can use the OrientXpres tool to limit the edit to be parallel an axis or plane you
select.

• When using the BlueDot command in Wire Harness, you can connect the end point of
more than two harness elements.
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Lesson 23: Activity: Creating and editing BlueDots

Overview

In this activity, learn to manually create and edit BlueDots.

Objectives

After completing this activity you will be able to:

• Create BlueDots.

• Edit BlueDots and curves based on them.
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Lesson 24: Open part file

▸ Open surface lab 2-02.par.

Note

Curves must be connected in order to use them to create surfaces. Only the Swept Surface
command does not require input curves to be connected. You will learn more about this
in the next lesson.

Note

The order in which you select curves determines which curve will change location. The
first curve you select moves to connect to the second curve. The first curve sketch plane
changes to the connected location. The second curve you select does not change.

Note

There are several curve selection locations. See the topic on BlueDot Creation in the theory
section of this lesson.
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Lesson 25: Use BlueDots to connect two curves

Experiment with connecting two curves using different selection locations. Remember to undo after
each connection to return the curves to their original location.

▸ Click Surfacing tab→Modify Surfaces group→BlueDot command .

▸ Select curve 1 at the location shown and then select curve 2 at the location shown. Notice
the resulting connection and then click Undo.
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Lesson 26: Connect the four curves at the end points

After having experimented with different curve selection possibilities, connect the four curves at
the end points.

▸ Click the BlueDot command and connect the curves in the sequence shown below (1-2, 3-4, 5-6,
and 7-8).

Note

Make sure the endpoint connect symbol displays before you click.

Right-click to finish.
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Lesson 27: Edit a BlueDot

The four curves are now BlueDot connected. Edit a BlueDot to observe how the curves behave.

▸ Select the BlueDot shown. Use QuickPick as an aid to select it.

▸ On the command bar, select Dynamic Edit .

▸ Click the Z-direction axis on the 3D triad as shown.

This locks the BlueDot movement to the Z-direction.
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Lesson 27: Edit a BlueDot

▸ Edit the BlueDot by dragging it in the graphics window or by typing a new Z-coordinate value.
Drag the BlueDot a small distance as shown and observe the behavior of the connected curves.

Note

Both curves are set to Local Edit.

▸ Click Undo to return the BlueDot to its original location.

▸ Set both curves to Shape Edit.
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Edit a BlueDot

▸ Select the BlueDot. On the command bar, select Dynamic Edit again. Notice the different result.

▸ Click Undo to return the BlueDot to its original location.

▸ On the command bar, select Dynamic Edit again.

▸ Edit a BlueDot by specifying a delta distance. Repeat the previous step, but this time click the
Relative/Absolute Position option on the BlueDot Edit command bar.

▸ Notice that the command bar changes to dX, dY and dZ. Type 20 in the dZ box and Enter.

Note

If you Enter a second time, a delta value of 20 is applied again.

▸ Click Undo to return the BlueDot to its original location.
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Lesson 27: Edit a BlueDot

▸ The 3D triad can be moved if it gets in the way. Click the 3D triad as shown and drag to a new
location.

▸ The activity is complete.
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Lesson 28: Summary

In this activity you learned how to draw and edit curves based on BlueDots.
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Lesson 29: Lesson review

Answer the following questions:

1. What is an edit point on a curve?

2. How do you display the control polygon of a curve?

3. Explain the differences in Shape Edit, Local Edit, and Rigid when moving a point on the curve.

4. How do you change the degree of a curve?

5. Explain what a BlueDot is and what impact it has on curves.

6. How do you convert analytics to B-splines?

7. What is the Curvature Comb used for?

8. On the BlueDot command bar, what does the Relative/Absolute Position option do?
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Lesson 30: Lesson summary

Surface shapes are directly tied to the curves defining those surfaces. Therefore, the control of
curves is crucial in modifying surface topology.

A curve:

• Can be edited by moving its edit points and control points.

• Can be further controlled by increasing its degree.

• Can be drawn directly by first defining edit points. Direct methods include:

o Curve

o Curve by table

o Contour curve

• Can be created indirectly from existing curves and surfaces, making them dependent on
underlying parent curves and surfaces. As the parent changes, so do the indirect curves.

Indirect curve methods are covered in the next chapter.
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Lesson 31: Indirect curve creation techniques

Objectives

After completing this lesson, you will be able to:

• Use the following commands to create curves derived from other geometry:

o Project curves

o Intersection curves

o Cross curves

o Contour curves

o Derived curves

o Offset edge

o Split curves

o Keypoint curves

o Curve by table

• Define and edit pierce and silhouette points.

• Draw curves overtop of a raster image.
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Lesson 32: Project Curve command

Use the Project Curve command to project one or more curves (2D or 3D) onto a surface or set
of surfaces. You can project the curve along a vector or along surface normals. You can also use
this command to project a point onto a surface.

Use the command bar to specify that you want to project a single element, a chain of elements,
a point, or an entire sketch.

Wireframe elements selected from multiple Parasolid bodies remain associative.

Note

When projecting a curve onto a cylinder, make sure that the curve endpoints do not lie on a
silhouette edge of the cylinder when viewed from the projection plane normal. Extend the
edges of the curve past the cylinder edge.
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Lesson 33: Project Curve Options dialog box

Along Vector
Specifies that the curve or point be projected along a vector you define.

Normal to Selected Surface
Specifies that the curve or point be projected along surface normals.
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Lesson 34: Intersection Curve command

Use the Intersection Curve command to create an associative curve at the intersection of two
sets of surfaces. The surface sets can be any combination of reference planes, model faces, or
construction surfaces.

An intersection curve is associative to the surfaces it is based on, so the curve updates if either set
of surfaces changes.

For example, you can intersect a cylinder (1) with a reference plane (2). The resulting intersection
curve (3) can then be used as input for constructing a feature or in a surface trimming operation.
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Lesson 35: Cross Curve command

Use the Cross Curve command to create a 3-D curve at the intersection of two curves.

• The command works much like the Intersection Curve command, yet it does not need existing
surfaces to create a curve.

• The only input required is two curves/analytics or a combination of the two.

• An intersection curve is created with the theoretical extruded surfaces resulting from the two
input curves or analytics.
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Lesson 35: Cross Curve command

(1) and (2) are the input curves. (3) and (4) are the theoretical extruded surfaces. (5) is the resultant
cross curve.
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Lesson 36: Contour Curve command

Use the Contour Curve command to draw a curve directly on a surface.

You can then use the curve for such things as a border in trimming operations

or as a tangent hold line in rounding operations.

You can select a single face or multiple faces when defining the faces on which you want to draw the
curve. You can only draw within the bounded region and the curve will only lie within the bounded
region. Curves that fall off the surface or surfaces or traverse trimmed regions are trimmed.

When defining the points for the curve you can use existing points that define the surface, such as
vertices, line midpoints, and edges of the surface.

You can add and delete points for the curve to follow and you can drag the points anywhere on
the surface.
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Lesson 36: Contour Curve command

Tips for creation and manipulation of contour curves.

• Choose Contour command bar→Draw Points step→Insert Point to insert additional points
into the curve. To delete a point from the curve, hold the Shift key and click on the point or
right-click on the point.

• You can connect a keypoint and an existing keypoint. To do this, right-click the existing keypoint
and select Connect; follow the prompts to identify the other keypoint.

• You can delete the connect relationships on a keypoint so that you can drag the keypoint on a
face. To delete the relationship, right-click the relationship and follow the prompts.

• You can drag an existing point to a new location on the face.

• When drawing a curve across faces that are not tangent, you must place a point at the shared
edge.
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Lesson 37: Derived Curve command

Use the Derived Curve command to construct a new curve that is derived from one or more input
curves or edges. If all the input curves or edges are connected at their endpoints, you can specify
that the derived curve is constructed as a single b-spline curve. If the input curves are connected,
but not tangent, the output curve will have a minimal amount of curvature added so that a single,
smooth b-spline curve is constructed.

You can construct a single derived curve from multiple bodies. For example, you can construct a
derived curve from a sketch (1), edges on a construction surface (2), and edges on a solid (3).
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Lesson 38: Offset Edge command

Use the Offset Edge command to offset the selected edges to create an imprint of them on a
part or surface by a given distance and direction. You can use this command in synchronous and
ordered environments in part and sheet metal models.

Eligible selected edges must form a closed loop on the same plane, or a tangentially continuous
chain of edges that do not lie on a planar face. You can select multiple edges from the same solid or
surface, or edges across multiple solids and surfaces.

• A closed loop that is tangentially connected:

• A closed loop that is not tangentially connected:

For finite element analysis models that contain representations of bolts, you can use the Offset Edge
command to produce better meshing results around bolt holes. In this application, the command
generates offset faces to represent where each bolt, nut, and washer come in contact with a hole.
This produces more nodes for the spider mesh to connect to and a better representation of the bolt.

Note

You can use the Derived Curve command to produce a new curve that is derived from
one or more input curves.
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Lesson 39: Split Curve command

Use the Split Curve command to split a construction curve. You can select keypoints, curves,
reference planes, or surfaces as the elements which split the curve.

Splitting a construction curve can make it easier to construct other features, such as a bounded
surface, a trimmed surface, a normal protrusion, or a normal cutout.

Note

You cannot use the Split Curve command to split an edge on a model. You can use the
Derived Curve command to create an associative copy of an edge on the model, then use
the Split Curve command to split the derived curve.

Split Curve command bar
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Lesson 40: Keypoint Curve command

Use the Keypoint Curve command to create a 3-D curve through a set of three or more points.
The points can be points you create with the Point command, keypoints on wireframe elements
and edges, or points in free space.

You can use this command to create a bridge curve (1), which can be used as a path for a swept
feature (2).

When you select a keypoint on a wireframe element or edge as the endpoint (3) of the curve, the End
Conditions Step allows you to specify whether the curve is created tangent to the wireframe element
or edge you selected. When you specify that the curve is tangent to an element at its endpoint, you
can also modify the magnitude of the tangent vector by dragging the tangent vector handle (4) to
a new location. When you modify the magnitude of the tangent vector, you also may change the
radius of curvature of the curve. If the modified curve was used as a path for a swept feature, the
swept feature will also update.
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Lesson 40: Keypoint Curve command

You can use the OrientXpres tool to help you define the location of a point on a keypoint curve.
For example, you can use OrientXpres to lock input to a particular axis or plane when creating
or editing a keypoint curve.

Inserting points to a curve

You can add new points along a curve or add a point in free space to add a new segment to the
end of the curve.

To add a point along a path, while editing the curve, hold the Alt key and click the location along the
curve where you want to add the point.

To add a point to the end of the path, while editing the curve, hold the Alt key and click a location in
free space where you want to add the point.

Removing points from a curve

You can remove a point from a curve.

To remove a point, while editing the curve, hold the Alt key and click the point you want to remove.
When you remove edit points, the control vertex points move and the shape of the curve changes.

If you remove the start or end point of a curve, the path truncates to the next control on the curve and
the tangency of the next point remains the same.

Defining curve length

You can set the Curve Length options for the keypoint curve definition. When this option is set,
the curve length remains fixed during an edit. You click the Fixed Length (1) button to lock the curve
length (3). The Constrain Direction (2) button defines the direction that the control points move
when you edit the curve length You can constrain along the X, Y and Z axis or any linear edge/curve
or axis. The increase or decrease in length bows in that direction.
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Keypoint Curve command

Note

Synchronous keypoint curves cannot be edited after creation.

Dimensioning a keypoint curve

When placing a Smart dimension on a keypoint curve, the dimension type is set to Length (2),
unlocked (1), and cannot be edited.
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Lesson 41: Curve By Table command

The Curve By Table command uses an Excel spreadsheet to define a construction curve.
The spreadsheet, which is embedded in the Solid Edge document, allows you to better import and
manage engineered curves. You can generate a curve by creating a new spreadsheet or by opening
an existing spreadsheet. For example, you can create two helix curves using a spreadsheet with the
Curve By Table command. You can then use these curves as paths to construct swept protrusions.

Note

To create a curve using the Curve By Table command, or to edit an existing curve, Microsoft
Excel must be loaded on your machine.
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Lesson 42: Isocline command

Use the Isocline command to place an isocline curve on one or more selected faces. An
isocline curve is a curve connecting points on a surface whose surface normal makes a constant
angle to the direction of pull (4).

The required inputs are: a reference plane, surface body, and an angle.

The above example shows two single isocline curves (1) created on a spherical surface (3), at 30
and 60 degrees from the reference plane (2).

You can see the relationship between the angle and where the isocline curve is created. The direction
vector (4) is normal to the reference plane.

You can create isocline curves on any selected face, or on multiple faces. You may need to flip the
direction vector to get corresponding isocline curves on adjacent faces.

The input angle range is 0.00 < 90.00 degrees.

Use isocline curves to:

• Split a surface.

• Construct parting lines and parting surfaces on a mold or casting.

• Analyze a face/surface using draft angle map (family of isoclines).

• create new surfaces.
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Lesson 43: Create an isocline curve

1. Choose Surfacing tab→Curves group→Isocline .

2. Select a reference plane or planar face.

3. Select a surface body.

4. In the Angle edit box, type an angle within the range of 0.00 to less than 90.00 degrees.

5. Click the Accept button.

Note

You can click the direction arrow (1) or press F to get another possible isocline curve result.
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Chapter 44: Activity: Creating keypoint curves

Chapter 44: Activity: Creating keypoint curves

Overview

In this activity, you learn to create a keypoint curve. A keypoint curve is a 3D curve. The curve is
defined by connecting to keypoints from existing geometry.

Objectives

After completing this activity you will be able to:

• Create a keypoint curve.

• Modify tangency vectors.
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Open the part file

Chapter 45: Open the part file

▸ Open surface lab 2-03.par.

Note

The part file contains three sketches that you use to create keypoint curves. Each sketch
has seven keypoints.
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Chapter 46: Create a keypoint curve

Chapter 46: Create a keypoint curve

Create the first keypoint curve using geometry from Sketch A.

▸ Click Surfacing tab→Curves group→Keypoint Curve .

▸ Click the endpoint shown. Make sure the endpoint connect symbol displays.

Note

There are other keypoint select locations possible on a line. You can select endpoint
(1), midpoint (2), line and endpoint (3) or line and midpoint (4). If you select a line and
endpoint or a line and midpoint, the curve becomes tangent to the line at that point. You
can modify the tangent vector. For this activity, only select endpoints.

▸ To make it easier to only select endpoints, click the Keypoints button on the command bar.

Select the Endpoint option .
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Create a keypoint curve

▸ Click the remaining endpoints in the following order.

▸ After clicking the last endpoint, click the Accept button, and then click Finish.

▸ Repeat the previous step to create keypoint curves using Sketches (2) and (3).
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Chapter 47: Create keypoint curves between the sketches

Chapter 47: Create keypoint curves between the sketches

Create seven keypoint curves between the sketches. The first curve is shown below and also the
completed curves.
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Create keypoint curves between the sketches

▸ Press Escape. Right-click in space, and then select Hide All→Sketches.

Note

The keypoint curves are not connected to each other. They are only connected to
the sketch elements. If you edit one of the sketches used to keypoint connect to, the
keypoint curve changes with edits made to the sketch.
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Chapter 48: Connect the keypoint curves with BlueDots

Chapter 48: Connect the keypoint curves with BlueDots

Connect the keypoint curves with BlueDots. Once a BlueDot is added, the creation history of the
curves is lost.

▸ Click the BlueDot command .

▸ Click keypoint curve 1, and then click keypoint curve 2 as shown.

Note

Make sure no keypoints display when selecting the curves to BlueDot connect. Just
click the curve away from any possible keypoint.
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Connect the keypoint curves with BlueDots

▸ Continue placing the remaining BlueDots. There are a total of 21 BlueDots. In case of a mistake,
click the Undo command.
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Chapter 49: Edit a BlueDot

Chapter 49: Edit a BlueDot

Edit a BlueDot and observe how the keypoint curves behave.

▸ Click the Select tool.

▸ Select the BlueDot shown.

▸ Click Dynamic Edit on the command bar.

▸ Click the Z-direction on the 3D triad.
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Edit a BlueDot

▸ Drag the BlueDot up and notice how the two keypoint curves remain connected.

Note

Notice on the BlueDot Edit command bar that curve edit fields are not available.
Keypoint curves cannot be controlled with local or shape edits.

▸ Click the Select tool. Right-click in the graphics window. Choose Hide All→BlueDots and
Hide All→Curves.
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Chapter 50: Include tangency on keypoint curves

Chapter 50: Include tangency on keypoint curves

Create two keypoint curves that include a tangency vector.

▸ Click the Select tool.

▸ In PathFinder, select the check boxes next to features Extrude 4 and Extrude 5.

▸ Create keypoint curves between these two surfaces that are tangent to an edge of each surface.
Choose the Keypoint Curve command to begin.

▸ Select the surface edge as shown. Make sure the line and endpoint highlight.

▸ Select the surface edge as shown. Make sure the line and endpoint highlight.

▸ Click the Accept button.
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Include tangency on keypoint curves

▸ Click the End Conditions Step.

▸ Set the start and end tangent conditions to Tangent.

Note

Notice the green dot and line on each surface edge. These are the tangency vectors.
The keypoint curve is tangent to the surface edge. By dynamically dragging the green
dot, the curve changes shape while remaining tangent.

▸ Drag the tangency vectors as shown.
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Chapter 50: Include tangency on keypoint curves

▸ Click Preview and then click Finish.

▸ Create another keypoint curve on the opposite edges of the surfaces.

Note

In the next lesson, you learn that the two keypoint curves you just created are a step
in the process of constructing a tangent transition surface between two surfaces. The
activity is complete.
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Summary

Chapter 51: Summary

In this activity you learned how to create and edit keypoint curves.
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Chapter 52: Activity: Additional curve creation methods

Chapter 52: Activity: Additional curve creation methods

Overview

In this activity, you will learn additional methods of creating curves. So far, you have learned to draw
curves directly, point by point. Now you will learn to create curves indirectly, by combining inputs
from existing curves and surfaces.

Objectives

After completing this activity you will know how to use:

• Intersection curves

• Cross curves

• Projected curves

• Contour curves

• Derived curves

• Split curves
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Open the part file

Chapter 53: Open the part file

▸ Open surface lab 2-04.par.

Note

In order to create curves in this activity, existing construction surfaces are needed. Since you
have not yet learned how to create surfaces, the surfaces needed in the activity are provided.
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Chapter 54: Create an Intersection curve

Chapter 54: Create an Intersection curve

▸ In PathFinder, select the check boxes next to features BlueSurf 1 and Extrude 1.

▸ Right-click in the graphics window and choose Hide All→Reference Planes.

▸ Create a curve where construction surfaces (1) and (2) intersect. Choose Surfacing tab→Curves

group→Intersection .

▸ On the command bar, set the Select filter to Feature.

▸ Select surface (1) and Accept.

▸ Select surface (2) and Accept.

▸ Click Finish.

54-1 Modeling a part using surfaces spse01560

Chapter 54: Create an Intersection curve



Create an Intersection curve

Note

In PathFinder, notice the intersection curve just created is named Intersection 2.

Note

The intersection curve is associative to the two input surfaces it was created from.
These surfaces are the parents of the intersection curve. If a parent is edited, the
intersection curve updates automatically.

In the next lesson you learn how you can use the intersection curve in surface editing operations.

▸ Hide the following features in PathFinder: BlueSurf1, Extrude1 and Intersection 2
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Chapter 55: Create a cross curve

Chapter 55: Create a cross curve

A cross curve is an intersection curve that is created with the theoretical extruded surfaces resulting
from the two input curves or analytics.

▸ In PathFinder, show the following sketches: Sketch 2a and Sketch 2b.

▸ Select Surfacing tab→Curves group→Cross .

▸ Click sketch (1) and then click Accept. Click sketch (2) and then click Accept.

55-1 Modeling a part using surfaces spse01560

Chapter 55: Create a cross curve



Create a cross curve

▸ Click Finish.

The cross curve is the result of the intersection of the two theoretical extruded surfaces (1) and (2).

Note

The Cross command eliminates the need to construct extruded surfaces from curves
and then find the intersection between the two surfaces.

▸ Hide the sketch curves and cross curve: Sketch 2a,Sketch 2b and Cross Curve 8.
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Chapter 56: Project a curve

Chapter 56: Project a curve

The Project command projects a curve onto a surface.

▸ Show the following features in PathFinder: BlueSurf 2 and Sketch 3c.

▸ Project curve (2) onto surface (1). Choose Surfacing tab→Curves group→Project .

▸ Click the Options button on the command bar.

▸ The default option is Along vector. This projects a curve along its normal vector. Click OK.

▸ Select curve (2) and then click Accept.

▸ Select surface (1) and then click Accept.
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Project a curve

▸ For the direction vector, point the direction arrow down as shown.

▸ Click Finish.

▸ Click the Select tool. In PathFinder, select the Projection feature and press Delete.

▸ Project the curve normal to the surface. Select the Project command again.

▸ Click the Options button.

▸ Select the Normal to selected surface option and click OK.
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Chapter 56: Project a curve

▸ Click the curve and then click Accept.

▸ Click the surface and then click Accept. Click Finish. Notice the different results

▸ Hide the features BlueSurf 2 , Sketch 3c and Projection 9.
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Create a contour curve

Chapter 57: Create a contour curve

▸ In PathFinder, show the feature BlueSurf 2.

▸ Select Surfacing tab→Curves group→Contour .

▸ Click the surface and then click Accept.

▸ Click the surface to place the six contour curve points approximately as shown. Points 1 and 6
are on the edge. Points 2 through 5 are on the face.
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Chapter 57: Create a contour curve

Note

To insert points on an edge, set the command bar Select box to Edges. To insert points
on the face, set the Select box to Face.

▸ After placing the last point , click Accept. Click Finish.
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Edit the shape of the contour curve

Chapter 58: Edit the shape of the contour curve

▸ Click the Select tool.

▸ In PathFinder, right-click the contour curve feature and select Edit Definition.

Note

The shape can be edited while creating the contour curve.

▸ Click Draw Points Step .

▸ Click the points shown and drag to edit the shape approximately as shown. Points 1 and 6 will
remain attached to the edge. Points 2–5 can be moved anywhere along the face.
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Chapter 58: Edit the shape of the contour curve

▸ Click Accept and then click Finish.

▸ Hide the two features BlueSurf 2 and Contour Curve 2.
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Use the derived curve and split curve creation methods

Chapter 59: Use the derived curve and split curve
creation methods

You can create derived curves from the four edges of a surface. Then you can split the derived curves
that would be used to create additional surfaces. No surfaces are created in this activity.

▸ In PathFinder, show BlueSurf 1.

▸ Select Surfacing tab→Curves group→Derived .

▸ Click the edge shown, and then click Accept.

▸ Click Finish.
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Chapter 59: Use the derived curve and split curve creation methods

▸ Repeat the above step to create derived edges for the three remaining surface edges.

▸ Click the Select tool. Hide the surface.

▸ In PathFinder, show the Base Reference Planes.

▸ Select Surfacing tab→Curves group→Split .

▸ Select the derived curve shown, and then click Accept.

▸ On the Split Curve command bar, set the Select filter to Body.
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Use the derived curve and split curve creation methods

▸ Click the reference plane shown.
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Chapter 59: Use the derived curve and split curve creation methods

▸ Click Accept, and then click Finish.

Notice the original derived curve is now split and there are two new curves that can be used for
surfacing operations.
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Use the derived curve and split curve creation methods

▸ Repeat the previous step to split the remaining three derived curves.

The following image shows a new surface created using the split curves.

Note

The BlueSurf construction method was used to create the surface above. You will learn
how to create BlueSurfs in an upcoming lesson.

▸ The activity is complete. Exit and Save the file.
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Chapter 60: Summary

Chapter 60: Summary

In this activity you learned how to create curves using several additional methods.
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Lesson 44: Pierce points

A pierce point is the point of intersection between a profile element and the active sketch plane.

Example

You can use a connect relationship to position the element you are drawing to where a
profile element on another reference plane pierces the current profile plane.

Pierce points:

• Are extremely valuable in aligning curves.

• Recognize where a 3D curve, a sketch, or an edge passes through (pierces) the active profile
plane.

• Connect geometry to curves intersecting a profile plane.

• Are useful for creating guide paths for BlueSurf and Sweep operations.
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Lesson 45: Silhouette points

Silhouette points are keypoints that occur on an arc, circle, or ellipse.

Example

When you draw a new line, you can touch the silhouette point on a circle. When you click,
the new line is connected to the silhouette point on the existing circle.

Silhouette points:

• Are defined relative to the horizontal and vertical axis of the draft sheet or profile/sketch plane.

• Constitute any point where a plane parallel to the base reference plane passes tangent to
a given curve.

• Can be used to connect dimensions.

• Act like endpoints.
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Lesson 46: Insert Image command

Use the Insert Image command to insert an image into a document. Inserted images can
contribute to your modeling workflow in several ways. For example, you can sketch geometry over
an image to create features based on it. Or you can use an image as a label or decal on a plane
or planar face in the model.

You can insert image files of the following types:

• Windows Bitmap (*.bmp)

• Portable Network Graphics (*.png)

• Graphics Interchange Format (*.gif)

• Joint Photographic Experts Group (JPEG) (*.jpg, *.jpeg, *.jpe)

• Tagged Image File Format (TIFF) (*.tif, *.tiff)

Note

JPEG image files must be in RGB format. CMYK format is not supported.

You can either link or embed the image, and you can control its display, including height, width,
and aspect ratio.

In a draft document, another way to insert an image is to drag it from your desktop onto the working
sheet, or copy and paste it from an external application, such as Microsoft Paint. Pictures inserted in
this manner are created as image objects rather than as symbols.
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Lesson 47: Points, curves (and surfaces) as
construction elements

For some model types, you may not use the solid modeling commands until very late in the modeling
process. Complex, freeform parts often require that you begin the modeling process by defining points
and curves, which are used to define and control the surfaces that comprise the model. Surfaces are
then generated, and in the final steps, the surfaces are stitched together to form a solid model.

• These construction element types can be created within Part, Sheet Metal, and Profile or Sketch
environments:

o Points

o Curves

o Surfaces

Construction elements that drive other features have a parent-child relationship with the features
they drive. If you delete a construction element that is a parent to another feature, you can invalidate
the other feature.

Displaying construction elements

• Use the View tab→Show group→Construction Display command to control display.

• Construction elements are listed in the Feature PathFinder.

Note

When hidden, a construction element entry in PathFinder changes to indicate that it
is hidden.

• Color control is available for construction elements using either of the following:

o The View tab→Color Manager command

o The Colors tab in the Solid Edge Options dialog box.

• Specific display considerations:

o Construction elements used to create new features are not consumed by the new feature,
and are hidden by default.

o It can be useful to hide the design body while you are working with construction surfaces.
Under View tab→Show group→Construction Display, use either the Show Design Body
or Hide Design Body commands.
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Lesson 47: Points, curves (and surfaces) as construction elements

Methods of creating construction elements

• Use existing geometry on the model. Intersection curves, Keypoint curves, Derived curves,
Project curves, Split curves, and relevant point creation commands can be used.

• Create construction elements from scratch using the Solid Edge construction surface creation
commands (extruded, revolved, and swept surfaces).

• Use Curve By Table command to generate a curve based on input points.

• Use an external file. For example, you can create a helix curve using coordinate data in
a spreadsheet.

• Import them from another CAD system. For example, you can import surfaces and solids from
a third-party CAD system.

• Generate them as a part copy from another Solid Edge part. For example, you can create
construction geometry using the Part Copy command on the Insert menu.

Using construction elements

• Points can be used in several ways:

o To create other features:

■ Use a construction point or curve as a path or cross section for lofted and swept features.

■ Use the Intersection command to create cross sections for lofted features.

o To define the extents of another feature:

■ Use keypoints of construction curves to define the extent for a feature.

■ Use the Intersection command to create associative points as input to define the
extents of a feature

• Curves can be used in two distinct ways:

o Curves can be used to create other features, such as:

■ Paths and cross sections for lofted and swept features using Intersection curves,
Keypoint curves and Derived curves.

■ Profiles for profile-based features using the Project (useful for creating embossed text
on a curved surface) and Split (divide one into multiple curves to create a normal
protrusion) commands:

■ Construction surfaces—the Split command can divide one construction surface into
multiple curves to create a surface by boundary.

o Use a construction curve as input to the reference plane Normal To Curve command.

• Surfaces can be used as well; creation methods are covered in other training modules. Some
general uses of surfaces are:

47-2 Modeling a part using surfaces spse01560

Lesson 47: Points, curves (and surfaces) as construction elements



Points, curves (and surfaces) as construction elements

o To define the projection extents when extruding a feature. For example, a construction
surface can be used as input during the Extent step when constructing a protrusion.

o To replace existing part faces.

o To divide a part into multiple parts.

o To create a new surface or solid by stitching together separate surfaces. Use the Offset
Surfaces command to offset a new surface.

o To repair a model imported from a third-party CAD system.

o Construction surfaces are commonly used as projection extents when extruding a feature.
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Lesson 48: Lesson review

Answer the following questions:

1. How do you get tangency control on a keypoint curve?

2. Intersection curves are considered to be associative. What does this mean?

3. From what types of elements can a derived curve be formed?

4. Generally, why would you define construction elements (curves and points) as a first step?
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Lesson 49: Lesson summary

• You can create various curves indirectly from existing curves and surfaces. These curves are
controlled by the parent curves and surfaces. As the parents change, so do the indirect curves.

• Surface shapes are directly tied to the curves defining those surfaces. Therefore, the control of
curves is crucial in modifying surface topology.

• Pierce and silhouette points can assist in connecting curves to off-plane geometry.
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Lesson 50: Surface creation

Objectives

After completing this lesson, you will be able to:

• Create simple surfaces.

• Create a BlueSurf.

• Edit a BlueSurf.

• Create a Bounded surface.
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Overview of surfaces
A surface is a 3D element that is controlled by curves. Surfaces have no thickness and therefore can
be visualized as a thin sheet. The complexity of a surface is directly proportional to the number of
curves used to define it. A small, underlying curve set produces a relatively simple surface, while
a complex face consists of a large number of curves. In Solid Edge modeling, a surface consists
of cross-sections and guide curves. Guide curves may be preexisting or interpolated from the
cross-section elements.

(1) Guide curves
(2) Cross Section curves

Curves form the mathematical basis of a surface. As your understanding of how to control curves
increases, your mastery of surfaces grows.

There are two basic ways curve manipulation affect an associated surface:

1. Editing underlying cross-sections and guide curves directly modifies surface shape.

2. A surface can be trimmed and extended using curves and edges.

Once its shape is finalized, a surface can be used in the creation of additional faces via the following
commands (covered in Lesson 5):

• Offset

• Copy

• Mirror

A surface also can be stitched together with other faces to form a solid, or it can include rounds
between adjoining surfaces.
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Tangency control handles
Use the tangency control handles to specify the tangency condition at curve and surface boundaries.
These handles provide a direct method to manipulate the shape of a surface by specifying different
tangency conditions.

The BlueSurf, Bounded, Redefine, Lofted, and Keypoint Curve commands support various
continuity and tangency conditions. The tangency control handles provide a common method for
each of these commands to control the end conditions.

The handle has two elements:

• Tangency control handle (1) – Drop-list to control the type of tangent condition

• Tangent magnitude handle (2) – Drag handle which also supports a magnitude dynamic input
box (3).

Tangent conditions
natural (1)
normal to section (2)
parallel to section (3)
tangent continuous (4)
alternate tangent continuous (5)
curvature continuous (6)
alternate curvature continuous (7)
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There are two tangent magnitude handle options that are available when creating and editing a
bluesurf surface, loft protrusion, or keypoint curve.

• Multiple tangent magnitudes (1)

This option exposes all magnitude handles for the section. You can edit any magnitude handle
and the remaining handles are unchanged.

• Single tangent magnitude (2)

This option exposes a common magnitude handle for the section. You edit a common magnitude
handle and the remaining section magnitude handles have the same value.

You can drag the handles or type a magnitude value in the dynamic input box.

Tangency handle display

Tangency handle display can be turned on or off in each command.

• BlueSurf command— Use the on or off button in the BlueSurf-Surface Visualization dialog box.
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• Bounded command — Use the Hide Tangency Control Handles button on the Bounded
command bar. The button appears while in the Face Tangency step.

• Redefine command — Use the Hide Tangency Control Handles button on the Redefine
command bar. The button appears while in the Tuning step.

• Keypoint Curve command — Use the Hide Tangency Control Handles button on the
Keypoint Curve command bar. The button appears while in the End Conditions step.

spse01560 Modeling a part using surfaces 50-5

Surface creation



Lesson 50: Surface creation

Creating a simple surface
The two most basic surface creation techniques utilize the Extruded

and Revolved surface commands.
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Extruded command

Use the Extruded surface command to create a construction surface by projecting a profile along
a straight line. Options are available to control the extents of the surface.

When you create an extruded surface using a closed profile, you can use the Open Ends and
Close Ends options on the command bar to specify whether the ends of the surface are open (1)
or closed (2). When you set the Close Ends option, planar faces are added to the ends of the
feature to create a closed volume.

When constructing extruded surface features, you can also apply draft angle or crowning to the
faces on the feature that are defined by profile elements. For more information, see the Applying
Draft Angle and Crowning to Features Help topic.

spse01560 Modeling a part using surfaces 50-7

Surface creation



Lesson 50: Surface creation

Revolved command

Use the Revolved surface command to create a construction surface by revolving a profile
around an axis of revolution.

When you create a revolved surface using a closed profile that is revolved less than 360 degrees,
you can use the Open Ends and Close Ends options on the command bar to specify whether the
ends of the surface are open (1) or closed (2). When you set the Close Ends option, planar faces
are added to the ends of the feature to create a closed volume.
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Activity: Creating and editing simple surfaces

In this activity, you will learn to create and edit simple surfaces. You will use sketches in a training file
to create an extruded surface and a revolved surface. After completing the surface, you will edit the
sketch curve to observe the surface shape changes.

Objectives

After completing this activity you will be able to:

• Create and edit an extruded surface.

• Create and edit a revolved surface.
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Open part file
▸ Open surface lab 3-01.par.
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Create an extruded surface
▸ In PathFinder, show Sketch A.

▸ Select Surfacing tab→Surfaces group→Extruded .

▸ On the command bar, from the Create-From list, select Select from Sketch.

▸ Click the sketch curve shown and then click Accept.

▸ Click the Symmetric Extent button and type 150 in the Distance box.

▸ Click Finish.
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Modify the shape of the extruded surface
▸ Click the Select tool.

▸ In PathFinder, hide Base Reference Planes.

▸ Select the extruded surface and then click the Dynamic Edit button on the command bar.

▸ Click the sketch curve. Use the curve Local Edit option , and drag the edit point shown.
Drag the edit point around slightly and notice how the surface shape changes.

▸ Click the Select Tool to end the dynamic edit, and then press Escape.

▸ In PathFinder, hide the features Sketch A and Extrude 3.

50-12 Modeling a part using surfaces spse01560

Lesson 50: Surface creation



Surface creation

Create a revolved surface

Note

The Revolved surface command has the same steps as the part Revolve command.

▸ Show Sketch B.

▸ Select Surfacing tab→Surfaces group→Revolved .

▸ On the command bar, from the Create-From list, select Select from Sketch.

▸ Select the sketch curve shown and then click Accept on the command bar.

▸ Notice on the Revolved surface command bar that the next step is to define the axis of revolution.
Click the line as shown.

▸ For the extent step, click the revolve 360° button .
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▸ Click Finish.
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Edit the shape of the revolved surface
▸ Click the Select tool.

▸ Press Ctrl+R to rotate the view to a right view.

▸ Select the revolved surface and then click the Dynamic Edit button .

▸ Select the sketch curve. Use the curve Local Edit option and drag the edit point shown.
Drag the control vertex point around slightly and notice how the surface shape changes.

▸ Drag the control vertices around to come up with your own surface shape.

▸ This concludes the activity.
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Summary
In this activity you learned how to create simple surfaces using Extrude and Revolve, and how to edit
the surfaces by manipulating their parent curves.
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Using simple surfaces as construction surfaces

Creating simple construction surfaces

Besides representing a very simple method of creating needed faces, the extruded and revolved
surface commands can be used to build construction surfaces necessary for generating intersection
curves with other faces. In this situation, the surfaces can be hidden after the operation is complete.
This is preferred to deleting the faces, because they are the parents of the intersection curves.

Deleting construction surfaces

If you need to delete a surface, and if that face has children (the intersection curve, possibly others),
use the Drop Parents command to permit the curves to remain after the surface is removed.
However, those curves are no longer associated, and cannot be edited. Therefore, caution is advised
when using the Drop Parents command.

To hide the display of surfaces, right-click in the part window and choose Hide All→Surfaces.
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Tear-Off Sketch
Typical surface design methodology creates several curves on three base planes. As new planes
are created, adding and copying profiles can be tedious, if not impossible. The Tear-Off Sketch
command provides a clear modeling advantage in that it:

• Transfers or copies sketches from one plane onto another.

• Quickly creates new cross sections without having to define a plane and include geometry.

• Replicates sketches quickly for use in swept or lofted protrusions.

• Creates new sketches which are parallel or perpendicular, along curves, angular associative,
copied or moved.
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Tear-Off Sketch command

Use the Tear-Off Sketch command to copy or move a sketch and layout elements from one
reference plane to another. This allows you to divide a large sketch into a series of smaller sketches,
which can make it easier to complete the part or assembly you are documenting. For example,
you can associatively copy a single sketch to a series of sketches using reference planes normal
to a curve.

You can then use the resulting sketches as cross sections for constructing a feature such as a
swept surface.

You can use the Tear-Off Sketch Options dialog box to:

• Copy sketch elements associatively

• Copy sketch elements non-associatively

• Move sketch elements

When you copy sketch elements associatively, a special symbol (1) is added to the copied sketch
elements to indicate that the copied elements are associatively linked to the original sketch elements.
If you modify the original elements, the associative elements also update.
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When selecting the sketch to tear off, you can select a single sketch element or a chain of sketch
elements. You can only tear off sketch elements within the same sketch. If you select multiple sketch
elements, all the elements are copied or moved either associatively or non-associatively. You cannot
copy some of the elements associatively and some of them non-associatively.

After you copy or move the elements to the new sketch, you can use the Reposition button on the
Tear-Off Sketch command bar to connect keypoints of an element profile to a pierce point that
passes through the target reference plane. In the Assembly environment, the pierce point option
is not available.

You can connect multiple keypoints on a torn off sketch to multiple keypoints. For example, you can
connect keypoints on a sketch to multiple guide curves. You have to select the Reposition button for
each new position definition.

50-20 Modeling a part using surfaces spse01560

Lesson 50: Surface creation



Surface creation

Swept command

Use the Swept surface command to construct a surface by extruding one or more cross sections
(1) along a path you define (2).

You can define up to three paths and many cross sections. After you define the third path, the
command automatically proceeds to the cross section step.

The cross sections can be open or closed and can be planar or non-planar. You can place them
anywhere along the path. For predictable results, it is best if the cross sections intersect all paths.
The sweep paths can be either tangent or non-tangent.

When you create a swept surface using a closed sketch, you can use the Open Ends and Close
Ends options on the command bar to specify whether the ends of the swept surface are open or
closed. When you set the Close Ends option, faces are added to the ends of the feature to create a
closed volume.

You can select wireframe elements from multiple Parasolid bodies or sketches and the elements
will remain associative.
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Activity: Creating a swept surface

Overview

In this activity, you will learn to create and edit a swept surface. You will use provided sketches to
create a swept surface. After completing the surface, you will edit the sketch path and cross sections
to observe the surface shape changes.

Objectives

After completing this activity you will be able to create and edit a swept surface.
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Open the part file
▸ Open surface lab 3-02.par.

The part file contains four sketches. Sketch element (1) is the guide path (curve) and sketch elements
(2–4) are the cross sections (arcs).

Note

The Swept surface command has the same steps as the part Swept Protrusion command.
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Create a swept surface

▸ Select Surfacing tab→Surfaces group→Swept .

In the Sweep Options dialog box, select Multiple paths and cross sections. Click OK.

▸ For the Path step, select the curve shown and then click Accept.

▸ Since there is only one path, click the Next button on the command bar to proceed to the
Cross Section step.

▸ Select cross section 1, and then click Accept. Select cross section 2 and click Accept. Select
cross section 3 and click Accept.
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▸ On the command bar, click Preview and then Finish.
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Modify the shape of the surface

▸ Click the Select tool. Select the surface, and then click Dynamic Edit .

▸ Click the 70 mm radius dimension on cross section 1. Type 50 and press Enter.

▸ Click the 10 mm radius dimension on cross section 2. Type 40 and press Enter.

▸ Click the 60 mm radius dimension on cross section 3. Type 20 and press Enter.
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▸ Click the Select tool to end the dynamic edit. Press Escape to finish.
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Dynamically edit the path curve

▸ Click the Select tool. Select the surface and then click Dynamic Edit .

▸ Click the path curve as shown.
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▸ Select the edit point shown and drag it to the right.

▸ The activity is complete.
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Summary
In this activity you learned how to create and edit a swept surface.
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Bounded Surface command
Use the Bounded surface command to create a construction surface using boundary elements
you define. The boundary elements can be curves or edges and they must define a closed area
(1). You can also specify whether any adjacent faces (2) are used to control tangency on the new
bounded surface (3).

• The curve/edge set must form a closed loop.

• Adjacent faces can be used to control tangency on the new bounded surface.

• The preparation of edges/curves to be utilized may require the use of the derived curve and
split curve commands.

• The keypoint curve command can be used to generate a boundary curve.

Inserting sketches

You can use the Insert Sketch Step on the command bar to add new sketches to a Bounded feature.
The geometry for the new sketch is created by intersecting a reference plane you define with the
Bounded feature. You do not have to create the sketch geometry yourself. When you insert a sketch,
the new geometry is a created as a B-spline curve. If you want the new geometry to consist of lines,
arcs, or circles, you must create the new sketch manually outside of the Bounded surface command.

When you click the Insert Sketch button on the command bar, plane creation options are added to
the command bar so you can define the position for the new reference plane. For example, you can
use the Parallel Plane option to define an offset reference plane where you want additional control
over the resultant surface.
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You can then edit the sketch to change the surface shape.

When you add a cross section or guide curve to an existing Bounded Surface feature using the Insert
Sketch option, the new sketch is connected to the cross sections or guide curves. You can use the
Bounded Surface Options dialog box to specify whether Pierce Points or BlueDots are used to
connect new section to the surface.

Note

BlueDots are only available in the ordered modeling environment

Pierce points

When you set the Use Pierce Points option, connect relationships are used to tie the inserted
sketch to the cross sections or guide curves it intersects. When you set the Use BlueDots
option, BlueDot elements are used to tie the inserted sketch to the cross sections or guide curves
it intersects. The option you specify also affects how you can edit the feature later.

When you connect the new sketch using the Use Pierce Points option, you can modify the cross
sections or guide curves the new sketch intersects and the B-spline curve for the inserted sketch
will update. The Use Pierce Points option is most suitable for models that must conform to
engineering data or dimension-driven criteria, such as turbine blades, fan housings, and so forth.
The Use Pierce Points option maintains the existing parent/child history of the model.

BlueDots

If you are working with a Bounded Surface in the ordered environment, and you insert a sketch
using the Use BlueDots option, you can also modify the Bounded Surface feature by editing
the position of the BlueDots using the Select Tool and the BlueDot Edit command bar. When
you move a BlueDot, the portion of the sketches that are controlled by the BlueDot update,
and that portion of the BlueSurf also updates.

The Use BlueDots option is most suitable for ordered models that are driven by esthetic
requirements, such as consumer electronics products, bottle and container design, and so forth.
When you use BlueDots to connect an inserted sketch, moving a BlueDot can also change the
location of the reference planes of the sketches it connects.

This is because a BlueDot allows you to override the existing parent/child history of the model.
For example, if you insert a sketch using a parallel reference plane with an offset value of 25
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millimeters, editing the location of the BlueDot can also change the offset value of the reference
plane.

This behavior can be preferable when exploring the esthetic possibilities of a surface, but can
be counter-productive when working with engineered surfaces. In some cases, using BlueDots
can also cause a model to take longer to update, because moving a BlueDot may require more
of the model to recompute than a connect relationship would.

Note

When you set the Use BlueDots option on the Bounded Surface Options dialog
box, but existing constraints prevent BlueDots from being created, then pierce points
are created instead.
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Ruled Surface command
Use the Ruled surface command to create a surface that extends out in a specified direction
from a selected edge.
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BlueSurf overview

BlueSurf is a surface creation command used to generate complex, but highly editable surfaces. Like
loft and sweep, a BlueSurf utilizes cross sections and guide curves, and these parent curves drive the
behavior of the resultant surface. Several techniques can be applied to further edit a BlueSurf.

• New sections and guides can be incorporated, providing additional control over the BlueSurf
topology.

• As sections and guides are added, the number of edit points can be increased or reduced through
the concept called Edit Point Data Management.

• BlueDot edit points can be moved in order to manipulate the surface; both Shape and Local
Edits are available.

The first step in creating a BlueSurf is selecting cross sections. The Cross Section Step activates
automatically. At least two cross sections are required.

Next, you can select guide curves if needed. Click the Guide Curve Step and select the guide
curve(s).

Click Preview and then Finish.

The example below shows the BlueSurf result of two cross sections (C1, C2) and two guide curves
(G1, G2).
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A BlueSurf may also consist of a single cross section and a single guide curve. The following example
shows the BlueSurf result of using cross section (C1) and guide curve (G1) from the previous example.

At this point, editing any of the cross sections or guide curves modifies the shape of the BlueSurf.
If you need additional surface shape control, the BlueSurf command provides a step to insert
additional sketches.
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BlueSurf command

Use the BlueSurf command to construct a surface using existing sketches or part edges. You
can use the BlueSurf command to construct complex surfaces that provide many editing options.

Input requirements

The sketches or edges can represent cross sections only (1) or cross sections (1) and guide curves
(2). At a minimum, you must define two cross sections or one cross section and one guide curve.

The sketches or part edges can be open or closed.

Mixing open and closed elements

When constructing a BlueSurf feature, you can use both open and closed elements in a single
feature. For example, you can construct a BlueSurf feature that uses a line and a closed element,
such as a rectangle or a circle, as cross sections. In some situations, you may need to split elements
or define vertex mapping parameters to construct the surface you want. For example, to construct a
BlueSurf feature using a line and a circle, you must split the circle into two arcs. You can use the Split
command to split the circle into two connected arcs.
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Closing ends

When you create a BlueSurf feature using closed cross sections, you can use the End Capping
options on the BlueSurf Options dialog box to specify whether the ends of the feature are left open
(1) or closed (2). When you set the Close Ends option, a solid construction body is created.

Inserting sketches

You can use the Insert Sketch Step on the command bar to add new sketches to a BlueSurf feature.
The geometry for the new sketch is created by intersecting a reference plane you define with the
BlueSurf feature. You do not have to create the sketch geometry yourself. When you insert a sketch,
the new geometry is a created as a B-spline curve. If you want the new geometry to consist of lines,
arcs, or circles, you must create the new sketch manually outside of the BlueSurf command.

When you click the Insert Sketch button on the command bar, plane creation options are added to
the command bar so you can define the position for the new reference plane. For example, you can
use the Parallel Plane option to define an offset reference plane where you want additional control
over the resultant surface.
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You can then edit the sketch to change the surface shape.

When you add a cross section or guide curve to an existing BlueSurf feature using the Insert Sketch
option, the new sketch is connected to the cross sections or guide curves. You can use the BlueSurf
Options dialog box to specify whether Pierce Points or BlueDotsare used to connect new section
to the surface.

Note

BlueDots are only available in the ordered modeling environment

Pierce points

When you set the Use Pierce Points option, connect relationships are used to tie the inserted
sketch to the cross sections or guide curves it intersects. When you set the Use BlueDots
option, BlueDot elements are used to tie the inserted sketch to the cross sections or guide curves
it intersects. The option you specify also affects how you can edit the feature later.

When you connect the new sketch using the Use Pierce Points option, you can modify the cross
sections or guide curves the new sketch intersects and the B-spline curve for the inserted sketch
will update. The Use Pierce Points option is most suitable for models that must conform to
engineering data or dimension-driven criteria, such as turbine blades, fan housings, and so forth.
The Use Pierce Points option maintains the existing parent/child history of the model.

BlueDots

If you are working with a BlueSurf in the ordered environment, and you insert a sketch using
the Use BlueDots option, you can also modify the BlueSurf feature by editing the position of
the BlueDots using the Select Tool and the BlueDot Edit command bar. When you move a
BlueDot, the portion of the sketches that are controlled by the BlueDot update, and that portion of
the BlueSurf also updates.

The Use BlueDots option is most suitable for ordered models that are driven by esthetic
requirements, such as consumer electronics products, bottle and container design, and so forth.
When you use BlueDots to connect an inserted sketch, moving a BlueDot can also change the
location of the reference planes of the sketches it connects.

This is because a BlueDot allows you to override the existing parent/child history of the model.
For example, if you insert a sketch using a parallel reference plane with an offset value of 25
millimeters, editing the location of the BlueDot can also change the offset value of the reference
plane.
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This behavior can be preferable when exploring the esthetic possibilities of a surface, but can
be counter-productive when working with engineered surfaces. In some cases, using BlueDots
can also cause a model to take longer to update, because moving a BlueDot may require more
of the model to recompute than a connect relationship would.

Note

When you set the Use BlueDots option on the BlueSurf Options dialog box, but
existing constraints prevent BlueDots from being created, then pierce points are created
instead.

Creating new sketches manually (ordered modeling)

Alternately, you can also create new sketches for a BlueSurf feature using the Sketch command, or
you can copy an existing sketch using the Tear-Off Sketch command. You can then edit the BlueSurf
feature and add the new sketches as cross sections or guide curves.

For example, when you add new cross sections, the system adds them after the existing cross
sections, regardless of their physical orientation with respect to the existing cross sections. You
can use the Reorder option on the Advanced tab on the BlueSurf Options dialog box to define
the cross section sequence.

Cross section and guide curve connectivity

If you use a guide curve to construct a BlueSurf feature, the guide curve must intersect each cross
section and be tangent continuous (the curve cannot have any sharp corners). To ensure that the
guide curve stays intersected to the cross sections, you should add a connect relationship or a
BlueDot at each intersection point.

End condition control

On-screen graphic handles will be displayed during placement and edit workflows to quickly change
the tangency controls for cross sections and guide curve. You can use the Tangency Control options
on the BlueSurf Options dialog box to define the end condition options you want for the resultant
surface. For example, you can specify that the surface is tangent to the adjacent surfaces.
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Many of the end condition options allow you to dynamically adjust the surface using a graphic handle
(1) or by modifying a variable in the variable table. For surfaces that have several graphic handles
or variables for a single cross section, you can create a master variable for all the variables that
control the cross section, and then use a formula to drive all the variables for that cross section
simultaneously.

BlueSurf features and lofted features

In many respects, a BlueSurf feature is constructed and behaves similarly to a lofted feature, such as
a lofted surface or a lofted protrusion. For example, you can reorder cross sections, define vertex
mapping rules, and define the end section conditions for a BlueSurf feature and a lofted feature.
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BlueSurf Options dialog box

Standard Tab Options
Tangency Control
Specifies the options you want for controlling the shape at the ends of the feature. For example,
when you are creating a BlueSurf feature that must blend smoothly with adjacent surfaces, you
can set the Normal to Section option to ensure a smooth blend between the existing surfaces.

The following options are available, depending on the geometry you select for the cross section
or guide curve:

Natural
There are no constraining condition enforced at the end sections. This is the default end
condition and is valid for any cross section type.

Normal to Section
End cross sections that are planar support a normal to section end condition. You can control
the length of the vector using the variable table or by modifying the vector handle in the
graphics window. In this example, the resultant surface illustrates the graphic handles (1) that
you can use to modify the surface.
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Parallel to Section
End cross sections that are planar support a parallel to section end condition. You can
control the length of the vector using the variable table or by modifying the vector handle
in the graphics window. To see the effect of this setting, compare the following illustration
of Parallel to Section with the Normal to Section example.

Tangent Continuous
End cross sections defined using part edges and construction curves support a tangent
condition. The tangent vector for the surface is determined by the adjacent surfaces. You can
control the length of the vector using the variable table or by modifying the vector handle in
the graphics window.
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Alternate Tangent Continuous
End cross sections defined using part edges and construction surfaces support a tangent
interior condition. Tangent Interior forces the surface to be tangent to the inside faces. For
example, the surface below has the Alternate Tangent Continuous option applied to both
cross section. The resulting surface is constructed tangent to the planar face.

Curvature Continuous
End cross sections defined using part edges and construction surfaces support a curvature
continuous condition. The tangent vector for the surface is determined by the adjacent
surfaces. You can control the length of the vector using the variable table or by modifying
the vector handle in the graphics window.
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Alternate Curvature Continuous
End cross sections defined using part edges and construction surfaces support a alternate
curvature continuous condition. The tangent vector for the surface is determined by the
alternate face at that end. You can control the length of the vector using the variable table
or by modifying the vector handle in the graphics window.

For more information and illustrations which show you how you can control the surface shape
at the ends of BlueSurf and lofted features, see the End Conditions section in the Constructing
Lofted Features (ordered) or Constructing Lofted Features (synchronous) Help topics.

Start Section
Specifies the tangency control option you want for the first cross section.

End Section
Specifies the tangency control option you want for the last cross section.

Edge Guide 1
Specifies the tangency control option you want for the first guide curve. The options available
for defining guide curve tangency conditions depend on the type of element you select for
the guide curve. For example, if you want to be able to control the tangency of the BlueSurf
feature with respect to an adjacent surface, use an edge on the surface as the guide curve
rather than, for example, the sketch that was used to construct the adjacent surface.

Edge Guide 2
Specifies the tangency control option you want for the last guide curve. The options available
for defining guide curve tangency conditions depend on the type of element you select for
the guide curve. For example, if you want to be able to control the tangency of the BlueSurf
feature with respect to an adjacent surface, use an edge on the surface as the guide curve
rather than, for example, the sketch that was used to construct the adjacent surface.

End Capping
Specifies the end capping options you want. This option is available only when the cross section
profiles are closed.

Open Ends
Specifies that no planar end caps are added to the feature.
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Close Ends
Specifies that planar end caps are added to the feature to create an enclosed volume.

Extent type
Controls whether or not the feature closes on itself.

Open
Specifies that the feature begins with the first cross section and ends with the last cross
section. The feature does not close on itself.

Closed
Specifies that the surface will close on itself. When you set this option, the first cross section
is also used for the last cross section.

Curve Connectivity
Specifies how a cross section and a guide curve are connected. These options only apply to new
sketches you add using the Insert sketch button on the command bar.

Use Pierce Points
Specifies that a connect relationship is used to connect the cross section and guide curve
where they intersect. The position of the connect relationship is calculated using the Pierce
Point option on the IntelliSketch dialog box. The Use Pierce Points option is typically used
when constructing engineered surfaces, such as the surfaces for a fan or turbine blade,
where engineering data or dimension-driven criteria must be maintained.

Use BlueDots
Specifies that a BlueDot is used to connect the cross section and guide curve where they
intersect. When you connect a cross section and a guide curve with a BlueDot, you can use
the BlueDot as a handle to dynamically modify the shape of the cross section and guide
curve. The Use BlueDots option is typically used when constructing esthetic surfaces, such
as the surfaces for consumer electronics product, where a more free-form approach to
surface design is desired.

Note

The Use BlueDots option is available only in the ordered modeling environment.
The BlueDots functionality is not available in the synchronous environment.

Inserted-Sketch
Allows you to define a tolerance value for sketches you insert. The tolerance value you specify
is used to control the complexity of the curve that is created.

Tolerance
Specifies the tolerance value you want to use.
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Advanced Tab Options
Vertex Mapping
Vertex mapping is a technique to help create flow between section vertices; you can map a vertex
or point on one cross section to a vertex or point on another cross section. Vertex mapping is
useful for controlling or eliminating twists and discontinuities in a surface. If there is a vertex count
mismatch between sections, equally spaced vertices are used on each section.

You can add vertex maps while creating a BlueSurf or by editing an existing BlueSurf.

Notice in the first image below that section (A) has four vertices and section (B) has three
vertices. The BlueSurf command automatically inserts vertices equally spaced on each section.
Notice the surface flow is not smooth.

The result of vertex mapping.

Map Sets
Lists the sets of mapped vertices you have defined. You can add vertex map sets to create
a smooth surface flow; to add a new set of mapped vertices, click the Add button, then
click a point on each cross section curve.

Add
Allows you to add a new mapped vertex set.

Delete
Allows you to delete an existing mapped vertex set.
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Reorder
Allows you to reorder cross sections that were defined out-of-sequence. This option is useful
when you modify an existing feature by adding a new cross section. You cannot use the
reordering capability to create a feature that intersects itself.

To reorder a cross section, select the cross section in the list, then click the Up or Down buttons
to move the cross section entry in the list.
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Insert sketches into a BlueSurf

In the following example, the Use BlueDots option is selected in the BlueSurf Options dialog
box for curve connectivity.

Inserting a sketch.

1. On the BlueSurf command bar, click the Insert Sketch Step. You must select a plane to insert
a sketch on. All of the plane creation methods are available.
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In the following example, the parallel plane option was selected. Reference plane (1) was
selected as the plane to be parallel to. Reference plane (2) can be dynamically dragged to the
location to insert a sketch. You can also key in a distance. Click location to insert a sketch (3).
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2. Insert a sketch (3) in the guide curve direction and notice the results. The parallel plane is used
again.
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3. Now turn off the reference planes and observe the results.

When the guide curve direction sketch was inserted, it crossed another sketch. The BlueSurf
command automatically inserts BlueDots at the intersection of the curves. If there were several
sketches in the cross-section direction, the inserted sketch in the guide curve direction would be
connected with BlueDots.
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Adding cross sections into a BlueSurf (ordered modeling)

Any cross section sketch created after the BlueSurf is created will not be seen by the BlueSurf
feature. When you edit a BlueSurf created in the ordered modeling environment, it only recognizes
sketches created before it was created.

To add a new cross section:

1. The BlueSurf feature below was created with two cross sections (C1, C2).

First, add a new cross section (C3) that was created before the BlueSurf feature.

2. Click the Select Tool and then select the BlueSurf feature. On the ribbon bar, click Edit Definition

.

3. On the BlueSurf command bar, click the Cross Section Step.

4. Identify the new cross section (C3). Notice that cross section C3 is placed last in the cross
section order, which causes the BlueSurf feature to reverse direction. The cross section order
below is C1, C2 and then C3. You can reorder the cross sections to make C3 be defined
between C1 and C2.
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5. On the BlueSurf command bar, click the options button. Click the Advanced tab.

Cross section C3 is shown as Section 3. To reorder C3 to be between C1 and C2, click Section 3
and then click Up. Click OK to apply the reorder.

The following shows the result with cross-sections ordered C1, C2 and C3.

Adding cross sections created after the BlueSurf feature

If you create a cross section (1) after the BlueSurf feature (2), the cross section will have to be moved
up in the feature tree to be recognized by the BlueSurf feature.
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To move the cross section up in the feature tree, click the Select tool. In PathFinder, click and hold
the Blue Surf and drag it below the latest sketch as shown.

The sketch can now be seen by the BlueSurf feature.
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Vertex mapping

Vertex mapping is a technique to help create flow between section vertices. If there is a vertex count
mismatch between sections, equally spaced vertices are used on each section.

Notice in the image below that section (A) has four vertices and section (B) has three vertices.
The BlueSurf command automatically inserts vertices equally spaced on each section. Notice the
surface flow is not smooth.

You can add vertex map sets to create a smooth surface flow. You can add vertex maps while
creating a BlueSurf or by editing an existing BlueSurf.

On the BlueSurf command bar, click the Options button. On the BlueSurf Options dialog box,
click the Advanced tab.
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Click Add and then select two vertices to be mapped together as shown.

Click Add again and select the next two vertices to be mapped together as shown.

Click OK in the dialog box and then Finish. The result is shown below.
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BlueSurf command bar

Main Steps
BlueSurf Options
Displays the BlueSurf Options dialog box.

Surface Visualization Options
Displays the Surface Visualization Options dialog box.

Cross Section Step
Selects the cross sections to which the feature will be fitted. You can select any number of cross
sections for a BlueSurf feature, using any combination of cross sections created from sketches
and cross sections created from part edges.

Guide Curve Step
Selects the guide curve for the feature to follow. To be valid, guide curves must touch each
cross section.
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Insert Sketch Step Options
Allows you to insert a sketch as a new cross section or guide curve. Inserting sketches between
existing cross sections or guide curves can give you more localized control over the resulting
surface. When you click the Insert Sketch Step button, the Defining a Plane options are
displayed, so you can dynamically define a new reference plane. When you click to define
the position for the new reference plane, Solid Edge creates the sketch by intersecting the
reference plane with the current surface. The inserted sketch is created as a B-spline curve
and is connected to the existing cross sections or guides curves using BlueDots (ordered
environment only) or connect relationships, depending on the options you set on the BlueSurf
Options dialog box.

Plane Options
Sets the method of defining the plane for the inserted sketch. Depending on the model you
are constructing, some of the options listed may not be available.

Coincident Plane
Specifies that you want to define a plane that is coincident to an existing reference plane or a
planar face on the part. When you set this option, a default X-axis and direction is applied
to the new reference plane. You can use keyboard accelerators to define a different X-axis
and direction for the new reference plane.

Parallel Plane
Specifies that you want to define a plane that is parallel to an existing reference plane or a
planar face on the part. When you set this option, you can specify the parallel offset distance.
When you set this option, a default X-axis and direction is applied to the new reference
plane. You can use keyboard accelerators to define a different X-axis and direction for the
new reference plane.

Angled Plane
Specifies that you want to define a plane that is at an angle to an existing reference plane or
planar face on the part. When you set this option, you can specify the angle value you want.

Perpendicular Plane
Specifies that you want to define a plane that is perpendicular to an existing reference plane
or planar face on the part.

Coincident Plane by Axis
Specifies that you want to define a plane that is coincident to an existing reference plane or a
planar face on the part. When you set this option, you define the X-axis and direction for the
new reference plane using a linear edge, a planar face, or another reference plane.

Plane Normal to Curve
Specifies that you want to define a plane that is perpendicular to a curve you select. This is
the default option when constructing a helix using the Perpendicular option.

Plane by 3 Points
Specifies that you want to define a plane by three keypoints you select.
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Tangent Plane
Specifies that you want to define a plane that is tangent to a curved face on the part. You
can select a cylinder, cone, sphere, torus, or b-spline surface. When you set this option, you
can also specify the angular rotation value. When you set this option, a default X-axis and
direction is applied to the new reference plane. You can use keyboard accelerators to define
a different X-axis and direction for the new reference plane.

Feature’s Plane
Specifies that you want to define a plane that is coincident to a reference plane used to define
an earlier feature. You can select the feature you want using Feature PathFinder or in the
graphic window. This option is not available when constructing the base feature.

Preview/Finish/Cancel
This button changes function as you move through the feature construction process. The
Preview button shows what the constructed feature will look like, based on the input provided
in the other steps. The Finish button constructs the feature. After previewing or finishing the
feature, you can edit it by re-selecting the appropriate step on the command bar. The Cancel
button discards all input and exits the command.

Command Tangent condition
Applies a command tangent condition to the boundary edges.

Show/Hide Tangency Control Handle
Show or hide the tangency control handle.

Deselect All
Deselects all inputs in the current step.

Select
Sets the edge selection method for defining the cross sections and guide curves. You can use
any combination of selection methods to select a set of edges. Hold the Ctrl key or the Shift key
to deselect an edge.

Single
Selects a single edge or sketch element.

Chain
Selects a sketch or a tangentially continuous chain of edges.

Loop
Selects all the edges of individual loops of a face by selecting the face and then choosing a
loop.

Face
Selects all the edges of a face by selecting the face.

Accept (check mark)
Accepts the edge selection criteria and selects all edges that meet the criteria. Right-click to
accept the selection or press Enter.
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Deselect (x)
Clears any selected edges and the edge selection criteria.

Other command bar Options
Open Ends
Creates the BlueSurf feature with open ends.

Closed Ends
Creates the BlueSurf feature with closed or capped ends

Name
Displays the feature name. Feature names are assigned automatically. You can edit the name
by typing a new name in the box on the command bar or by selecting the feature and using
the Rename command on the shortcut menu.
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Activity: Creating a BlueSurf using analytics

Overview

In this activity, you learn to create a BlueSurf feature. You will use provided sketches to create a
BlueSurf surface.

Objectives

After completing this activity you will be able to create a BlueSurf feature.
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Open the part file

▸ Open surface lab 3-03.par.
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Create several BlueSurf features

▸ Select Surfacing tab→Surfaces group→BlueSurf .

Notice on the BlueSurf command bar that the Cross Section Step is active.

▸ To define the first cross section, click the arc shown and then right-click (or click Accept).

▸ For the next cross section, click the arc shown and then right-click.

▸ For the last cross section, click the arc shown and then right-click.
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▸ Click Next, and then click Finish.

Notice the BlueSurf feature shown in PathFinder. Hide this feature.
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Create another BlueSurf

▸ Click the BlueSurf command.

▸ For the first cross section, select the point shown. Use QuickPick to select the vertex point.

▸ Click the arc shown for the second cross section, and then right-click.

▸ Click the arc shown for the last cross section, and then right-click.

▸ Click Next. Do not click Finish.

▸ Apply guide curves to the BlueSurf. Click the Guide Curve Step on the command bar.

▸ In the command bar Select list, click Single. This allows you to select single sketch elements
for the guide curve.
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▸ Select sketch elements (1) and (2) as shown, and then right-click to complete the first guide curve.

Note

Notice how the BlueSurf follows the guide curve.

▸ Select sketch elements (3) and (4) as shown, and then right-click to complete the second guide
curve.
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▸ Click Next and then Finish.

▸ Hide this second BlueSurf feature.
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Create a third BlueSurf

▸ Click the BlueSurf command.

▸ Click the point shown. Use QuickPick to select the vertex point.

▸ Click the cross section shown and right-click.

▸ Click the point shown and right-click. Use QuickPick to select the vertex point.

▸ Click the Guide Curve Step .

▸ From the command bar Select list, select Single.
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▸ Select sketch elements 1, 2, and 3 as shown, and then right-click. Select sketch elements 4, 5,
and 6 as shown, and then right-click.

▸ Click Next and then click Finish.
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Add cross sections to the BlueSurf

▸ Click the Select tool, and then select the BlueSurf feature.

▸ Click Edit Definition.

▸ Click the Cross section Step .

▸ Click the cross section shown and right-click.

▸ Click Edit on the error dialog box. The cross section order is the cause for the error. This will be
corrected later.

▸ Click the cross section shown and right-click.

▸ Click Edit on the error dialog box. The cross section order is the cause for the error. This will be
corrected later.

▸ Click the BlueSurf Options button.

▸ Click the Advanced tab in the BlueSurf Options dialog box.
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Notice the order of the Sections in the dialog box. Position the cursor over a section and it
highlights in the graphics window.

▸ Select Section 4, and then click the Up button to reorder the section between Sections 1 and 2.

▸ Select Section 5, and then click the Up button to reorder the section between Sections 2 and 3.

▸ Click OK.
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▸ Click Finish.

▸ The activity is complete.
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Summary

In this activity you learned how to create and edit BlueSurf surfaces.
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Activity: Creating and editing a BlueSurf

Overview

In this activity, you will learn to create and edit a BlueSurf. You will use provided curve sketches
to create a BlueSurf.

Objectives

After completing this activity you will be able to:

• Create a BlueSurf.

• Insert sketches.

• Edit BlueDots.

• Dynamically edit curves.
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Open the part file

Note

The part file contains four curves that are BlueDot connected.

▸ Open surface lab 3-04.par.
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Create a BlueSurf with guides

▸ Select Surfacing tab→Surfaces group→BlueSurf .

▸ Click curve (1) as shown for the first cross section and then right-click. Click curve (2) as shown
for the second cross section and then right-click.

▸ Click the Guide Curve Step .

▸ Click guide curve (3) as shown and then right-click. Click guide curve (4) as shown and then
right-click.

▸ Click Next, and then click Finish.
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Insert sketches on the BlueSurf

You can insert sketches to provide additional shape control.

▸ Click the Select tool, and then select the BlueSurf feature.

▸ Click Edit Definition.

▸ Click the Options button on the command bar.

▸ In the BlueSurf Options dialog box, under Curve Connectivity click Use BlueDots. Under
Inserted-Sketch, in the Tolerance box, type .01. Click OK.

Note

The tolerance controls the number of edit points used on inserted sketches.

▸ Click the Insert Sketch Step button .

▸ Click the Plane Normal to Curve option.

▸ Click the curve shown.
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▸ Notice a normal plane is attached to the curve, which can be dynamically dragged along the
curve. Drag the plane until the Position value is 0.25. You also can enter .25 on the command
bar. Click to place the plane.

▸ Repeat the previous step to insert sketches at positions .50 and .25 (from the opposite end)
as shown.

spse01560 Modeling a part using surfaces 50-79

Surface creation



Lesson 50: Surface creation

▸ Insert sketches normal to the cross section curve. Click the curve shown and insert sketches at
positions .25, .50 and .25 (from the opposite end).

▸ Click Finish twice.
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Perform BlueDot edits to change the shape of the surface

Edit the BlueDots along the center by changing their position in the Z-direction.

▸ Click the Select tool. Select the BlueDot shown and then click Dynamic Edit.
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▸ Click the Z-axis on the 3D triad.

▸ Click the Relative/Absolute Position button .
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▸ In the dZ box, type 5. Make sure Curves 1 and 2 are set to Shape Edit. Press Enter.

Note

If you press Enter again, the value is applied again.

▸ Click in open space in the graphics window to exit the BlueDot edit.
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▸ Repeat the previous step to edit BlueDots 2 through 5. Edit BlueDot 5 with a delta distance of 5.
Edit BlueDots 2 through 4 with a delta distance of 10.

▸ Right-click in the graphics window. Turn off the display of sketches and BlueDots.

▸ The activity is complete. Save and Close this file.
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Summary

In this activity you learned how to create and edit a BlueSurf.

spse01560 Modeling a part using surfaces 50-85

Surface creation



Lesson 50: Surface creation

Lesson review
Answer the following questions:

1. When do cross sections and guide curves have to be connected?

2. Name the two ways to edit a cross section or guide curve?

3. How do you add more cross sections to a BlueSurf?

4. How do you add more guide curves to a BlueSurf?

5. What happens to inserted sketches on a BlueSurf when the BlueSurf is deleted?

6. How do you get BlueDots on inserted sketches on a BlueSurf?

7. How do you turn off the display of BlueDots?
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Lesson summary
You control surfaces by curve definitions. You change the surface shape by editing the underlying
curves. You edit curves using Dynamic Edit or by editing the curve sketch or profile.

The extruded and revolved surfaces creation methods work similarly to the solid protrusion and
revolved protrusion commands. These surfaces are useful in the development of more complex
surfaces.

BlueSurf provides you the same results of a swept or lofted surface. However, BlueSurf provides
much more control and editing capability. You can add cross sections and guide curves. You can
control tangency at the start and end cross sections. You can use BlueDots or Pierce points to
connect the inserted cross section and guides. Editing the BlueDots gives you real-time surface
shape updates as they are moved.

Bounded surfaces are used to fill in gaps in a model. A bounded surface is created by selecting
edges (curves) that form a closed loop. You have the option to make the resulting surface tangent
to adjacent surfaces.
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Objectives

After completing this lesson you will be able to use the surface manipulation commands:

• Extend Surface

• Offset Surface

• Copy Surface

• Trim Surface

• Intersect Surface

• Delete Faces

• Stitched Surface

• Round

• Replace Face

• Split Face

• Parting Split

• Parting Surface
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Lesson 52: Extend command

Use the Extend surface command to extend a surface along one or more selected edges.

The selected edges can form a continuous chain (1) or be interrupted (2).
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The extend options which are available depend on whether the surface is an analytic surface or a
non-analytic surface. Examples of analytic surfaces include planes, partial cylinders, cones, spheres,
and tori. Sweeping or extruding a b-spline curve creates non-analytic surfaces. Constructing lofted,
swept or BlueSurf features using b-spline curves also creates non-analytic surfaces.

When extending a non-analytic surface, specify whether the extension is, Linear, Curvature
Continuous or Reflective along certain types of edges. For example, when extending an extruded
surface constructed using a b-spline curve, specify the Linear Extend, Curvature Continuous Extend,
or Reflective Extend options for the two edges which are parallel to the input b-spline curve (1, 2).

For the two edges which are perpendicular to the input b-spline curve (3, 4), only the Curvature
Continuous option is mathematically possible.

Additional examples are illustrated in the Extend Surface command bar topic.
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Use the Offset surface command to create a construction surface by offsetting a model face,
a reference plane, or another construction surface. The new surface is offset a specified distance
from the original surface, and is associative to it.
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If the face or surface has boundaries, Offset Surface has options to remove or keep the boundaries
on the offset surface.

The following illustration shows an offset surface (2) offset in direction (1) with the show boundaries
option on.
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Use the Copy surface command to create a construction surface feature that is derived from one
or more input faces. The faces you select do not need to be adjacent to each other. You can specify
whether any internal or external boundaries are removed on the new copy of the surface.

The following illustration shows surface face (1) copied with boundaries removed (2).
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Lesson 55: Trim command

Use the Trim surface command to trim one or more surfaces along the input element you define.
You can use a curve, reference plane, or another surface as the input element.

• If using curves,

o They must lie on the surface you are trimming. Use the Project command to project the
curve onto the surface first.

o Closed curves that do not completely lie on the surface are not supported.

o If using a surface as the trimming element the surface must touch or intersect the target
surface.

•
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Lesson 55: Trim command

o If the curve or surface boundary does not extend to the edges of the target surface, the trim
boundary element is extended linearly and tangent to the input element.

Note

Surface 1 is used to trim surface 2. Since surface 1 does not extend to the edges
of surface 2, linear extensions are added to the trim boundary element. The input
element you select as the trimming tool surface 1 is not modified.
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Lesson 56: Intersect command

Use the Intersect surface command to mutually extend or trim surfaces to a common
intersection. You can extend surfaces up to other surface bodies. The trim capabilities support
trimming multiple bodies. The intersect command can select only surface bodies, and all surface
bodies act as both a target and tool.

Note

When selecting surface bodies, selecting only two bodies enables both Extend and Trim
operations in the next step of the command. Selecting more than two bodies enables only
the Trim operation.

The example below shows a surface being extended.

The example below shows a surface being trimmed.

The example below shows a surface being trimmed via the region selection.
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Lesson 57: Delete Faces command

Note

To access the Simplify Model environment, choose Tools tab→Model group→Simplify.

Note

To access the Flatten Model environment, choose Tools tab→Model group→Flat Pattern.

Use the Delete Faces command to delete faces from the model.

You can use this command to do the following:

• To remove faces from a design model to make design changes.

• To simplify a model in the Simplify Model environment so that it processes faster when used
in an assembly.

• To remove faces from a sheet metal part when working in the Flat pattern environment.

• To remove faces from a construction body.

When you delete a face on a part body, which must always be a solid body, the gap created by the
deleted surface is automatically closed.

When you delete a face on a construction body, which is not required to be a solid body, you can
specify whether the gap is closed or left open using the Heal option on the command bar.

spse01560 Modeling a part using surfaces 57-1



Lesson 57: Delete Faces command

When you clear the Heal option, the gap is not closed and you can construct another surface to
close the gap. This can be useful when working with foreign data which cannot be converted into a
solid body when you import it.
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Lesson 58: Stitched command

Use the Stitched surface command to stitch together multiple, adjacent construction surfaces
to form a single construction surface feature.

• This command is useful for joining imported surfaces.

• If the stitched surfaces form a closed volume, you have the option to designate the solid body as
a base feature.

• You can set the stitched surface options for tolerance and surface healing on the Stitched
Surface Options dialog box.

• Notice the default tolerance on the Stitched Surface Options dialog box. Once you turn on the
Heal option, you can change this value if the edges of two surfaces being stitched together
do not meet the default tolerance.

Tips:

• To remove surfaces from the select set, select the surfaces while pressing Shift.

• To delete the link between the stitched surface feature and its parents, use the Drop Parents
command on the shortcut menu. This command reduces the amount of data in the file. Once you
drop the parent information, the stitch surface feature can no longer be edited.

• You can use the commands on the shortcut menu to display, hide, edit, rename, or recompute
the stitched surfaces.

• If the output forms a closed volume, a solid body will be created. Otherwise, the stitch surface will
be a sheet body with free edges that can be stitched to other surfaces.

• If the stitched surfaces result in a solid body and there is no base feature in the file, the Make
Base Feature command becomes available on the shortcut menu, and you can make the
stitched body the base feature for the part.
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Lesson 58: Stitched command

To show the stitchable edges on construction surfaces, choose Surfacing tab→Surfaces

group→Show Non-Stitched Edges located on the Stitched Surface command list.

The illustration below shows the stitchable edges for surface (1) and surface (2). Surfaces (1) and (2)
were stitched together to produce (3) and the stitchable edges are shown.

58-2 Modeling a part using surfaces spse01560

Lesson 58: Stitched command



Lesson 59: Round

You can use the Round command to place fillets and rounds on surface edges or between two
adjoining surfaces.
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Lesson 60: Blend command

Use the Blend command to create a variable radius round,

a blend between faces,

or a blend between surface bodies.
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Lesson 60: Blend command
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Lesson 61: Replace Face command

Use the Surfacing tab→Modify Surfaces group→Replace Face command to replace selected
faces on a part. The replacement face can be a construction surface, a reference plane, or another
face on the part. When replacing more than one face, the faces being replaced cannot touch each
other.

When you replace a face using a construction surface, the construction surface is hidden
automatically when you finish the feature.

If edges on the face you are replacing have rounds applied, the rounds are reapplied after you
complete the replace face operation.
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Lesson 62: Activity: Surface manipulation

Overview

In this activity you will learn to use the surface manipulation commands.

Objectives

After completing this activity you will be able to:

• Extend a surface.

• Offset a surface.

• Trim a surface.

• Copy a surface.

• Delete faces of a surface.

• Stitch surfaces together.

• Round surfaces.
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• Replace a face on a solid body.
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Lesson 63: Open the part file

▸ Open surface lab 4-01.par.
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Lesson 64: Extend a surface

▸ Select Surfacing tab→Surfaces group→Extend .

▸ Select the edge shown and click Accept.

Note

Notice on the Extend surface command bar the options for Linear, Curvature
Continuous, and Reflective Extent. The Linear option extends the surface in a linear
direction. The Curvature Continuous option extends the surface to follow the same
curvature of the select edge. The Reflective Extent option specifies that the extended
portion of the surface is a reflection of the input surface. This option is not available for
analytic surfaces.
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Lesson 64: Extend a surface

▸ Use the Curvature Continuous extent option and drag the distance vector approximately as
shown, and click.

▸ Click Finish.

▸ Click the Select tool.

▸ In PathFinder, select the new Extend feature and press Delete.

▸ Multiple edges can be extended. Select the Extend command again, select all four edges,
and click Accept.
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Extend a surface

▸ Drag the distance vector approximately as shown and click.

▸ Click Finish.

▸ Click the Select tool.

▸ In PathFinder, delete the Extend feature.
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Lesson 65: Offset a surface

▸ Select Surfacing tab→Surfaces group→Offset .

▸ Click the surface, and then click Accept.

▸ Type 50 in the Distance box and press Enter.
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Lesson 65: Offset a surface

▸ Position the direction arrow as shown, and click.

Note

The offset surface is offset along normal vectors from the input surface a distance
of 50 mm.

▸ Click Finish.
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Offset a surface

▸ Create another surface offset from the original (bottom) surface. Use 50 for the offset distance,
and position the direction arrow downward as shown.

▸ Click Finish.

▸ Click the Select tool.

▸ In PathFinder, delete the two offset surfaces.
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Lesson 66: Project a curve onto a surface

▸ In PathFinder, show Sketch B.

▸ Select Surfacing tab→Curves group→Project command .

▸ Select the circle shown below and then click the Accept button.

▸ Select the surface and click Accept. Position the direction arrow as shown and click.
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Lesson 66: Project a curve onto a surface

▸ Click Finish.

▸ The Project command is still active. Select the circle shown below and then click Accept.

▸ Select the surface and click Accept. Position the direction arrow as shown and click.

66-2 Modeling a part using surfaces spse01560

Lesson 66: Project a curve onto a surface



Project a curve onto a surface

▸ Click Finish.

▸ In PathFinder, hide Sketch B.
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Lesson 67: Trim a surface

Trim surface is used extensively in surface modeling.

▸ Select Surfacing tab→Modify Surfaces group→Trim .

▸ Select the surface and click Accept.

▸ Select the projection curve as shown and click Accept.

▸ Select the region labeled 1 as shown to trim the surface outside the projection curve.

▸ Click Finish.

▸ Select the surface and click Accept.

▸ Select the projection curve as shown and click Accept.
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Lesson 67: Trim a surface

▸ Select the region labeled 2 as shown to trim the surface inside the projection curve.

▸ Click Finish.

Notice the two Trim features in PathFinder.

▸ Right-click and Hide All→Curves.
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Lesson 68: Copy a surface

▸ Select Surfacing tab→Surfaces group→Copy .

Notice on the Copy surface command bar the two options for removing boundaries. To remove
internal boundaries on the copied surface, select the left button. Right-click to remove external
boundaries on the copied surface. If neither option is selected, the copied surface maintains
all boundaries.

▸ Click the Remove External Boundaries button.

▸ Select the surface and then click Accept.

▸ Click Finish.

Notice the Copy feature in PathFinder.

▸ Click the Select tool.

▸ In PathFinder, delete the following features: Projection 11, Projection 12, Trim 11, Trim 12,
and Copy 7.

▸ Hide feature Sweep A.
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Lesson 69: Delete faces

. Faces on a construction body can be deleted and replaced with a new surface.

▸ In PathFinder, show feature Extrude 2. Choose the Fit command.

▸ Select Home tab→Modify group→Delete Faces .

▸ Select the three faces shown and click Accept.
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Lesson 69: Delete faces

▸ Click Finish.

Notice the Delete Face feature in PathFinder.

▸ Hide feature Extrude 2. Show feature Extrude 3. The Extrude 3 feature was constructed with
a closed profile and the ends were capped.

▸ Click the Delete Faces command.

▸ Click the Heal Option button on the command bar.

Note

For the heal option to work, the construction body must be closed.

▸ Select the surface shown and then click Accept.
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Delete faces

▸ Click Finish.

Notice the result. The face was deleted and the two adjoining faces adjust to fill the gap. The
two end caps were also modified.

▸ Repeating the previous step, delete the face shown.
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Lesson 69: Delete faces

▸ Click Finish.

▸ Click the Select tool.

▸ Hide Extrude 3.
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Lesson 70: Stitch surfaces

▸ In PathFinder, show features BlueSurf 1, BlueSurf 2, BlueSurf 3, and BlueSurf 4.

▸ Select Surfacing tab→Modify Surfaces group→Stitched .

▸ Type .01 in the Stitch tolerance box and then click OK.

▸ Select all four surfaces and then click Accept.

▸ Click Finish.

Note in PathFinder the Stitch feature.

▸ Select Surfacing tab→Modify Surfaces group→Stitched list→Show Non-Stitched Edges

.
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Lesson 70: Stitch surfaces

▸ Click the stitched surface. Notice the highlighted edges. These are the unstitched edges.

▸ Click Close on the command bar.

▸ In order to make a solid feature there must be surfaces stitched to all of the non-stitched edges.
Create surfaces needed to make a solid feature. Select Surfacing tab→Curves group→

Keypoint Curve .

▸ Draw a keypoint curve as shown. The curve has two points.

▸ Create five bounded surfaces. Select Surfacing tab→Surfaces group→ Bounded .

▸ On the command bar, click the Select: Single option.

▸ Select the edges shown and click Accept.
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Stitch surfaces

▸ Click Finish.

▸ Repeat the same steps to create the bounded surface shown.
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Lesson 70: Stitch surfaces

▸ Repeat the steps for the three circular edges.

▸ Select the Stitched command. Type .01 in the Stitch tolerance box and click OK.

▸ Select the stitched surface and then select the five bounded surfaces.

▸ Click the Accept button. Since there are no non-stitched edges remaining, the stitched surfaces
result in a solid body. Click OK in the message dialog box.

▸ Click Finish.

Note

If there is no base feature (solid) in the file, you can right-click on the stitched surface
and click Make Base Feature to create a solid of the stitched surface.

▸ Click the Select tool.

▸ Hide features BlueSurf 1-4 and the keypoint curve.
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Lesson 71: Replace a face

▸ Select View tab→Show group→Construction Display. In the Show All/Hide All dialog box,
choose Show All→Design body. Protrusion A displays. Replace faces (1) and (2) on Protrusion
A with a construction surface.

▸ Show feature BlueSurf 7.

▸ Select Surfacing tab→Modify Surfaces group→Replace Face .

▸ Select the faces shown and click Accept.
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Lesson 71: Replace a face

▸ Select the surface shown for the replacement surface.

▸ Click Finish.

▸ Click the Select tool.

▸ Replace the bottom face on the protrusion. Show BlueSurf 8.

▸ Click the Replace Face command.
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Replace a face

▸ Select the bottom face as shown and click Accept.

▸ Select the surface shown for the replacement surface.

▸ Click Finish.

▸ This completes the activity. Exit and save the file.
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Lesson 72: Summary

In this activity you learned how to use several surface manipulation commands.
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Lesson 73: Split Face Command

Use the Split Face command to split one or more surfaces (1) using an element (2) you define.
You can select curves, edges, surfaces, reference planes, and design bodies as the elements that
split the face.

Splitting a face can be useful when constructing a model that you want to use for finite element
analysis purposes or when you want to isolate a portion of a face so you can to apply a decal or
image in a specific location.

If the element you are using to define the split location does not extend to the boundary of the face you
are splitting, the Split Face command will extend the imprinted splitting curve tangentially. The original
element you selected is not extended. For example, if you split a face using a sketch that consists of
a line and an arc, the imprinted curve is extended linearly and tangent to the original line and arc.

If the imprinted curves intersect when they are extended, the split face feature will not succeed.

When you use a surface as the splitting element, the surface must physically intersect the surface
you want to split. When you use a reference plane as the splitting element, the reference plane
must theoretically intersect the surface you want to split (the reference plane is considered to be
infinite in size).
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When you use curves or edges as the splitting elements, such as a sketch to split a face, the splitting
elements must lie on the face you are splitting. You can use the Project curve command to project
the elements onto the 3-D face.
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Split Face Command

What can go wrong-split face features
This topic gives you solutions to problems you might have when constructing split face features.

Missing Parent

Target faces must be from the same body: When constructing split face features, the faces you want
to split must be from the same body.

Targets and tools do not intersect. The splitting element does not intersect with the surfaces you
want to split.
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Lesson 74: Parting Split command

Use the Parting Split command to split a set of faces along the silhouette edges of the part,
which can be useful when working with a part that will be molded or cast. Parting lines are the same
as silhouette lines for a given face. You define the vector direction for calculation of the parting lines
by defining a reference plane (1). A parting split feature (2) is represented by curve.

To better illustrate the results, the surfaces which are split by the parting split feature are shown in
green and gold below. The surfaces shown in gray were not split. Surfaces which do not cross the
parting line and planar faces are not split by this command.
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Lesson 75: Parting Surface command

Use the Parting Surface command to construct a parting surface along a parting curve you
select. You construct a parting surface by selecting a reference plane (1) to define the orientation
of the linear cross section curve, and a 2-D or 3-D parting curve (2), which defines the sweep path
for the parting surface (3).

You create the parting curve in a separate operation. For example, you can use the Intersection
Curve command or the Parting Split command to create the parting curve.
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Lesson 76: Activity: Parting split and parting surface

Overview

When you complete this activity, you will be able to use the Parting Split and Parting Surface
commands.

Objectives

After completing this activity you will be able to use the following commands:

• Insert Part Copy

• Boolean

• Parting Split

• Parting Surface
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Lesson 77: Create a new part file

▸ Create a new ISO Meric Part.

▸ In PathFinder, right-click the Synchronous header and select Transition to Ordered.

Note

You will begin by constructing a core for the mold. The core needs to be sized to
accommodate the file pad.par that will be the cavity.
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Lesson 78: Create a sketch

▸ Turn on the display of the Base Reference Planes.

▸ Select Home tab→Planes group→More Planes→Parallel.

▸ Select the Top (xy) base reference plane indicated by the arrow. Create a parallel plane 35
mm above it as shown.

▸ Sketch the following profile on the parallel plane you just created. Make sure the midpoints of the
line elements are horizontal/vertical aligned to the center of the reference planes.

▸ Click Close Sketch and then click Finish.
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Lesson 79: Create the core part

▸ Select Home tab→Solids group→Extrude.

▸ Click the Select from Sketch option on the command bar.

▸ Select the sketch shown and click Accept

▸ Click the Symmetric Extent button and type 200 for Distance. Click Finish.

▸ In PathFinder, hide Sketch1.
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Lesson 80: Create the cavity

To create the cavity, use the Boolean difference to remove pad.par from the core.

▸ Select Home tab→Clipboard group→Part Copy .

▸ In the Select Part Copy dialog box, set Look in to the folder in which you installed the training
parts for this course. Select pad.par and click Open.

▸ In the Part Copy Parameters dialog box, make sure Copy as Design Body is checked and
uncheck the Merge Solid Bodies option. Click OK.

▸ Click Finish. Notice the feature Part Copy 1 is now listed in PathFinder. Use your cursor to
highlight this entry in PathFinder, and you can see the pad highlight in the graphics window.

▸ On the Home tab→Solid group→Add body list, choose the Subtract command .

▸ Select the extrusion (block) and then click Accept.
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Lesson 80: Create the cavity

▸ In the part window, select the part copy (pad.par) and then click Accept.

▸ Click Finish. Notice the Subtract feature listed in PathFinder.

The core now has a cavity of pad.par.
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Lesson 81: Create a parting split curve on the cavity

A parting split curve is derived from silhouette edges as viewed normal to a selected plane. The
parting split curve defines where a part needs to split to allow for removal from a mold.

▸ In PathFinder, in the Design Bodies collector, uncheck Design Body_2. This turns off the
display of the body.

▸ Right-click on Design Body_1 and choose the Activate Body command.

▸ On the Surfacing tab→Modify Surfaces group→choose the Parting Split command .

▸ Select the plane shown (Top (xy) base reference plane).

Note

You may want to change to a Wireframe view style for better visibility.

▸ On the Parting Split command bar, set the Select filter to Body.
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Lesson 81: Create a parting split curve on the cavity

▸ Select the body (block) as shown.

▸ Click Accept and then click Finish.

▸ Position your cursor on Parting Split 1 in PathFinder and notice the parting split highlights in
the graphics window.
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Lesson 82: Create a parting surface

This surface will be used to split the core in a later step.

▸ On the Surfacing tab→Modify Surfaces group→Parting Split list, choose the Parting Surface

command .

▸ Select the Top (xy) base reference plane.

Note

The parting surface will use this plane as reference for all normal vectors in creating the
surface.

▸ Select the parting split curve as shown and click Accept.

▸ Type 150 in the Distance field and press Enter.
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Lesson 82: Create a parting surface

▸ Position the arrow to point outward as shown and click. Click Finish.
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Lesson 83: Split the core

Note

Notice in Pathfinder that there are two solid bodies in the file.

Design Body_1 is the core and Design Body_2 is the pad.par that was subtracted from
the core.

Split the core along the parting surface to create mold halves. The core will be split into to solid bodies.

▸ On the Home tab→Solid group→Add Body list, choose the Split command .

▸ Select the core (1) and then select the parting surface (2).

▸ On the command bar, click Accept and then click Finish.
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Lesson 83: Split the core

▸ Click Finish.

Note

Only the active solid body shades. The other bodies are opaque. You can pause your cursor
over a solid body in Pathfinder to highlight it.
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Lesson 84: Create separate core parts

▸ Save the file.

▸ On the Home tab→Solid group→Add Body list, choose the Multi-body Publish command.

▸ On the Multi-body Publish dialog box, you can click the Set Path button (1) for the published
part files. The default path is the path of the active file. Click Save Files to create the part files.

▸ On the Multi-body Publish dialog box, click Close.

▸ Close the file.
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Lesson 85: Open core parts

▸ Navigate to the folder where the core parts were published.

▸ Open each core part and observe the results.

(1) Design Body_1.par, (3) Design Body_3.par.
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Lesson 86: Summary

In this activity you learned how to construct two halves of a mold from a single core part.
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Lesson 87: Activity: Putting it all together

Overview

In this activity, you will use the surfacing tools and workflows learned in this course to build a bathtub
spout.

Objectives

After completing this activity you will be able to:

• Read a control drawing.

• Create and edit curves.

• Create and edit surfaces.

• Make a solid feature.
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Lesson 88: Open the part file

▸ Open surface lab 4-02.par.

Note

Control Drawings were discussed in the previous lesson Surface Modeling. For this
activity the control drawing is provided. For ease of viewing, the curves in each sketch are
color-coded, and color references will be made when appropriate.
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Lesson 88: Open the part file

Control sketches (1)=Right View-ORANGE, (2)=Front View-PURPLE, (3)=Top
View-GREEN
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Lesson 89: Construct the top surface

Create intersection curves to be used to develop the top surface.

▸ On the Surfacing tab→Curves group, choose the Cross command .

▸ Click the Select from Sketch option.

▸ Select sketch element (1)—PURPLE—and then click Accept. Select both sketch elements
(2)—GREEN—and then click Accept.

▸ Click Finish.
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Lesson 89: Construct the top surface

▸ Choose the Cross command.
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Construct the top surface

▸ Select sketch element (3)—ORANGE—and then click Accept. Select sketch element
(4)—GREEN—and then click Accept. Click Finish.

▸ To create the top surface, on the Surfacing tab→Surfaces group, choose the Swept command

.

▸ In the Sweep Options dialog box, select the Multiple paths and cross sections option.
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Lesson 89: Construct the top surface

▸ For the Path Step, select path (1) and click Accept or right-click. Select path (2) and click
Accept or right-click.

▸ Click Next to proceed to the Cross Section step.

▸ On the command bar, click the Select: Single option.

▸ Select cross section (1) and right-click. Select cross section (2) and right-click. Select cross
section (3) and right-click.
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Construct the top surface

▸ Click Preview and then Finish.
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Lesson 90: Create intersection curves to develop
the front surface

▸ Hide the swept surface you just created.

▸ Choose the Cross command.

▸ Select sketch element (1)—PURPLE—and then click Accept. Select both sketch elements
(2)—ORANGE—and then click Accept.

▸ Click Finish.
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Lesson 90: Create intersection curves to develop the front surface

▸ Choose the Cross command.

▸ Select sketch element (3)—ORANGE—and then click Accept. Select sketch element
(4)—GREEN—and then click Accept. Click Finish.

▸ Click Finish.

▸ Save the file.

▸ Choose the Swept command. Click the Multiple paths and cross sections option and set
the Section Alignment to Parallel.
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Create intersection curves to develop the front surface

▸ Use QuickPick to select path (1). Make sure you select the cross curve element and then
click Accept. Select path (2) and right-click.

▸ Click Next to define the cross sections.

▸ Set the Select filter to Single. Select cross section (3) and right-click.

▸ Select cross section (4) and right-click.

▸ Select cross section (5) and right-click.
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Lesson 90: Create intersection curves to develop the front surface

▸ Click Preview and then Finish.

▸ Save the file.
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Lesson 91: Create intersection curves to develop
the side surfaces

▸ Hide the swept surface you just created.

▸ Choose the Cross command.

▸ Change the Select option to Single.

▸ Select sketch element (1)—PURPLE—and then click Accept. Change the Select option to
Single. Select both sketch elements (2)—GREEN—and then click Accept.

▸ Click Finish.
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Lesson 91: Create intersection curves to develop the side surfaces

▸ Choose the Cross command.

▸ Set the Select option to Single. Select sketch elements (3)—PURPLE—and then click Accept.

Note

There are two elements in (3).

▸ Set the Select option to Single. Select both sketch elements (4)—GREEN—and then click
Accept. Click Finish.

▸ Click Finish.
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Create intersection curves to develop the side surfaces

▸ On the Surfacing tab→Surfaces group, choose the Bounded command .

▸ Select the six edges as shown. Use QuickPick for edges (1) and (2) to ensure you select the
cross curve edges.
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Lesson 91: Create intersection curves to develop the side surfaces

▸ Click Finish.

▸ Create another bounded surface on the other side.

▸ Save the file.

▸ Show all of the surfaces created so far.
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Create intersection curves to develop the side surfaces
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Lesson 92: Create the bottom surface

▸ Show all base reference planes. On the Home tab→Sketch group, choose the Sketch command

.

▸ Select the Right (yz) plane for the first sketch.

▸ Hide all surfaces.

▸ Draw the following sketch.

▸ Select Close Sketch.
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Lesson 92: Create the bottom surface

▸ For the second sketch, create the sketch on a parallel plane as shown. To define the distance,
click the keypoint as shown.

▸ On the Home tab→Draw group, choose the Project to Sketch command. Select the arc shown.

Note

Click OK in the Include Options dialog box.

▸ Select Close Sketch.

▸ Choose the BlueSurf command.
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Create the bottom surface

▸ Select cross section (1) and right-click. Select cross section (2) and right-click.

▸ Hide all of the base reference planes.

▸ Click the Guide Curve Step.

▸ Select guide curves (3) and right-click.

▸ Select guide curves (4) and right-click.

▸ Select guide curves (5) and right-click.
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Lesson 92: Create the bottom surface

▸ Click Next and Finish.

▸ Save the file.

▸ Show all of the surfaces created so far.
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Create the bottom surface
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Lesson 93: Add another surface

You will add the surface as shown below.

▸ Hide all of the surfaces except the BlueSurf just created.

▸ To create this surface, an intersection curve is needed between the bottom BlueSurf and an
extruded surface created from the element shown in the control sketch. Create an extruded
surface with a symmetric extent from the element shown in the image below. Do not be
concerned with an exact distance.

spse01560 Modeling a part using surfaces 93-1



Lesson 93: Add another surface

▸ On the Surfacing tab→Curves group, choose the Intersection command. Select the BlueSurf
and the extruded surface as the surface set to intersect. The intersection curve is shown in the
image below. Hide the extruded surface after the intersection curve is created.
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Add another surface

▸ Hide all sketches. On the Surfacing tab→Modify Surfaces group, choose the Trim command.
Select and accept the BlueSurf. Change the Select option to Chain. Select the intersection curve
and select the region labeled 1 to remove as shown.

▸ Click Accept and Finish.
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Lesson 94: Create the final surface

▸ Show all sketches and curves.

▸ Choose the BlueSurf command.

▸ Select the cross sections shown. Set the Select option to Single in order to select the first cross
section (1). Select cross section (1) and right-click. For the second cross section (2), set the
Select option to Single in order to select the cross section. The second cross section (2) has 3
segments. Use QuickPick to ensure you pick the intersection edges. Select cross section (2)
and then right-click.
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Lesson 94: Create the final surface

▸ After selecting cross sections (1) and (2), click the Guide Curve Step. Set the Select option to
Single, select the curve (3) and then right-click.

▸ Click Next and Finish.

▸ Choose the Select command and right-click. Select:

• Hide All→Sketches

• Hide All→Curves

• Show All→Surfaces

Note

Hide the extruded surface you created as a construction surface.
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Lesson 95: Cap the ends

▸ Choose the Bounded command. Select the edges shown for (1). Select the edges shown for (2).

The surface model is complete.
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Lesson 96: Stitch together the surfaces

The surface model now can be converted to a solid base feature.

▸ Choose the Stitched Surface command and type .01 in the Stitch tolerance box. Click OK.

▸ Select all surfaces and then click Accept. Click Yes in the resulting solid message dialog box.

▸ This completes the bathtub spout lab activity.

Note

You rarely get the surface you want from the initial surface creation method. You also need
to manipulate the surface by adding boundaries, creating an offset, extending, rounding,
and so on.

Solid Edge provides several commands for you to use to develop the final surface shape. A
good understanding of these tools will help you master surface modeling.
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Lesson 97: Summary

In this activity you learned how to create a solid model from control curves using multiple curve
and surface manipulation techniques.
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Lesson 98: Lesson review

Answer the following questions:

1. What are the three extent options available on the Extend Surface command bar?

2. How do you create an offset surface without boundaries from an input surface that has
boundaries?

3. Can you trim a surface with multiple open curves in one step?

4. Can you trim a surface with multiple closed curves in one step?

5. How do you round a common edge of two separate surfaces?

6. Can multiple faces of a solid be replaced in one step?
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Lesson 99: Lesson summary

Many tools exist to modify surfaces. These commands greatly increase your ability to create and
control complex shapes.

After stitching surfaces together, Solid Edge automatically creates a solid body.

You can delete and replace faces as needed to optimize your design.

The Parting Split and Parting Surface commands facilitate the development of parts to be
manufactured in molds or dies (often called plastic parts).
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Lesson 100: Curve and surface inspection tools

Objectives

After completing this lesson, you will be able to:

• Understand and use curvature combs.

• Use Draft Face Analysis.

• Use Curvature Shading.

• Use Zebra Stripes.
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Lesson 101: Show Curvature Comb command

Use the Curvature Comb command to switch on or off the display of the curvature comb for a curve.
The curvature comb shows the smoothness of a curve.

Curvature combs help you determine how quickly or gradually curves change and where they change
direction. You can use the curvature comb to quickly determine the feasibility of machining and to
predict the aesthetic qualities of surfaces generated from a curve.

If you have a curvature comb displayed and use dynamic edit to make changes to the curve geometry,
the comb updates immediately to reflect the changes.
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Lesson 102: Surface inspection tools

Surface inspection tools are available in the Inspect tab→Analyze group.

• Draft Face Analysis

• Curvature Shading

• Zebra Stripes
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Lesson 103: Show Draft Face Analysis command

Displays colors on the model based on the surface angles with respect to a draft plane you define.
This is a visualization of whether a part can be removed from a mold or die. To display draft face
analysis colors, shade the active window using the Shaded or Shaded With Visible Edges
commands.

Use the Draft Face Analysis Settings command to specify the draft plane, draft angle, and assign
the colors to use.

Draft face analysis and view quality

The results of a draft face analysis depends on the current view quality. You might find that the draft
face analysis result changes if you modify the view quality. For example, if increasing the view quality
using the Sharpen command from 2 to 4, the results for the face shown in the illustration are changed
from a crossover face (A) to a positive face (B).

spse01560 Modeling a part using surfaces 103-1





Lesson 104: Show Curvature Shading command

Displays colors on the model based on the radius of curvature of the model's surfaces. Use the
command to graphically visualize the radius of curvature of a model. You must also shade the
active window using the Shaded or Shaded With Visible Edges commands to display curvature
shading colors.
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Lesson 105: Show Zebra Stripes command

Displays zebra stripes on the model. Zebra stripes are useful for visualizing the curvature of surfaces
to determine if there are surface discontinuities and inflections.

Note

You must also shade the active window using the Shaded or Shaded With Visible Edges
commands to display zebra stripes.

• Zebra Stripes are solid bands of color overlaid on top of a single face or set of surfaces:

o Displayed at regular spacing, controlled by the user.

o Follow the contour of the relevant faces.

• One might ask: “How do these 'stripes' help?”

o Smooth stripes are manifested by smooth, continuous surfaces (ie., no cusps or “wrinkles”).

o Stripes with sharp bends would indicate abrupt changes in surface curvature (ie., a
discontinuity).

o Discontinuities will make manufacturing more difficult.

■ Metallic Parts: Machining will be more complex.

■ Molded Parts: Injection of plastic may be difficult into discontinuous areas.

o You can control colors, spacing and the method of mapping the stripes using the Zebra
Stripes Settings.

Benefits

• Striping gives quick indication of continuous edges between faces.
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Lesson 105: Show Zebra Stripes command

• Dynamic; users can see changes in real-time.

• Non-rollback edit method.
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Lesson 106: Show Reflective Plane command

Turns the display of active reflective planes on or off. The reflective planes display a reflection of a
symmetrical part instead of an actual mirror feature. This is a quick way of resolving symmetrical form
and studying the volume of a sculpted model.

Reflective planes are used for display only. Reflective planes reflect model faces and curves.
Reflected faces include both construction and solid faces. Face styles are also reflected. Reflective
planes do not reflect coordinate systems, reference planes, sketches, or dimensions.

Use the Reflective planes dialog box for the reflectivity settings.
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Lesson 107: Isocline command

Use the Isocline command to place an isocline curve on one or more selected faces. An
isocline curve is a curve connecting points on a surface whose surface normal makes a constant
angle to the direction of pull (4).

The required inputs are: a reference plane, surface body, and an angle.

The above example shows two single isocline curves (1) created on a spherical surface (3), at 30
and 60 degrees from the reference plane (2).

You can see the relationship between the angle and where the isocline curve is created. The direction
vector (4) is normal to the reference plane.

You can create isocline curves on any selected face, or on multiple faces. You may need to flip the
direction vector to get corresponding isocline curves on adjacent faces.

The input angle range is 0.00 < 90.00 degrees.

Use isocline curves to:

• Split a surface.

• Construct parting lines and parting surfaces on a mold or casting.

• Analyze a face/surface using draft angle map (family of isoclines).

• create new surfaces.
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Lesson 108: Create an isocline curve

1. Choose Surfacing tab→Curves group→Isocline .

2. Select a reference plane or planar face.

3. Select a surface body.

4. In the Angle edit box, type an angle within the range of 0.00 to less than 90.00 degrees.

5. Click the Accept button.

Note

You can click the direction arrow (1) or press F to get another possible isocline curve result.
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Lesson 109: Surface Visualization command

Use the Surface Visualization command to display the UV Mesh and curvature combs on a
selected surface as defined in the dialog settings box. The UV Mesh or Isoparameter curve mesh are
lines running along the surface in the U and V directions, showing the shape of the surface. The
curvature comb shows the smoothness of a curve on the surface.

The following illustration shows U direction labeled as 1 and V direction labeled as 2.

The following illustration shows the curvature combs labeled as 3 for direction 1 and 2 respectively.
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Lesson 110: Lesson review

Answer the following questions:

1. What is the Curvature Comb used for?

2. In what situations would the Draft Face Analysis command be useful?

3. Explain the difference between Curvature Shading and Zebra Stripes.
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Lesson 111: Lesson summary

You have learned what curvature combs show, and how to modify their output. Methods for visualizing
the quality of surfaces have also been covered here.
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